AutoCAD Raster Design 2012

Getting Started

April 2011
# Contents

## Chapter 1  Welcome to AutoCAD Raster Design 2012

- Raster Design Documentation ........................................... 1
- About This Guide ......................................................... 1
- Documentation ............................................................. 2
  - Installation and General Product Information ................ 2
  - Help ............................................................................ 2
  - Automated Search ......................................................... 3
- Autodesk Training Programs and Products ......................... 5
  - Autodesk Authorized Training Centers ............................. 5
  - Autodesk Courseware ..................................................... 5
  - Autodesk Certification ................................................... 5
  - e-Learning .................................................................... 6
- Raster Design Home Page .................................................. 6
- Raster Design Basics ........................................................ 6
- When to Use Raster Design ............................................... 8
- Who Should Use Raster Design? .......................................... 9
- Image Types and Color Maps .......................................... 10
- Minimum Requirements .................................................. 11
- Software Requirements .................................................... 12
- Hardware Requirements ................................................... 13
- Network Installation of AutoCAD Raster Design ............... 13
- Starting Raster Design ...................................................... 13
- Exiting Raster Design ....................................................... 14
- Configuring Raster Design ............................................... 14
Welcome to AutoCAD Raster Design 2012

AutoCAD Raster Design allows you to effectively use scanned paper drawings, aerial photographs, digital elevation models (DEM) and satellite data inside your AutoCAD® drawings. You can insert bitonal, grayscale, and color raster images into your AutoCAD drawings, then correlate, edit, analyze, and export the results.

AutoCAD Raster Design can analyze and display image data from a wide range of sources, including satellite imagery, wavelet compressed images, and digital elevation models (DEM). Raster Design also provides efficient tools for cleaning up and archiving paper-based drawings in digital form.

Raster Design Documentation

About This Guide

This guide provides the information you need to get started with AutoCAD Raster Design. The first two chapters present the fundamentals of Raster Design. The third chapter, Task-Specific Concepts on page 53, explains how to do common image management tasks, and includes short LiveView exercises you can follow to get working with the application. Appendices cover the supported image formats and Raster Design commands. The glossary provides definitions of terms used with the software.
Documentation

In addition to this Getting Started guide, the following documents are also installed with the software and are accessible from the Help folder:

- Stand-Alone Installation Guide
- Network Administrator's Guide
- User's Guide
- Tutorials

Installation and General Product Information

The Raster Design installation wizard guides you through the installation and registration process. You can access the Stand-Alone Installation Guide, the System Requirements and the Readme, from the wizard to help you install the software.

Help

The Help files provide detailed reference information about options, commands and dialog boxes. You can access Raster Design Help files by using several different methods. Each method takes you to a different place in the Help file, and each method has its own benefits.

Accessing Help

If you use this method... | This is the result.
--- | ---
From the program group, select the Raster Design Help Files icon. or
Click Raster menu ➤ Help. | Displays a help window with two panes. The navigation pane on the left includes Contents, Index, Search, and Favorites tabs. Use these tabs to display information in the topic pane on the right side of the Help window.

Click the Help button in a dialog box. | Displays the Help topic that describes the options in the dialog box.

2 | Chapter 1   Welcome to AutoCAD Raster Design 2012
Many topics in Help feature three tabs that separate the information into three content types: Concept, Procedure, and Quick Reference. To move between tabs, simply click the tab.

When a Help topic is displayed, you can print the topic by clicking Options ➤ Print. Related topics appear as blue, underlined links. Glossary definitions of terms appear as green links; hover the cursor over a glossary link to see the definition, or click the link to go to the Glossary entry.

**Automated Search**

InfoCenter enables you to easily search for key terms or procedures across most of the documentation provided with Raster Design and the host products. Enter your search term in the text field in the upper right corner of your AutoCAD application window, then press Enter.

The search results are organized to indicate the source document, so that you can more easily determine which leads to follow.
In the sample results, note that the occurrences of the term “line width” are separated by product and document. In this case, Raster Design documents are at the top, and AutoCAD documents below. Some of the document panels, such as New Features Workshop, are collapsed in this view, but can be expanded by clicking the up/down arrow on the right. Use the small left/right arrows to scroll through the occurrences within a document. For more information on using InfoCenter, see AutoCAD Help.
Autodesk Training Programs and Products

Training programs and products from Autodesk help you learn the key technical features of your Autodesk software and improve your productivity. For the latest information about Autodesk training, visit http://www.autodesk.com/training or contact your local Autodesk office.

Autodesk Authorized Training Centers

Be more productive with Autodesk software. Get trained at an Autodesk Authorized Training Center (ATC) with hands-on, instructor-led classes to help you get the most from your Autodesk products. Enhance your productivity with proven training from over 1,400 ATC sites in more than 75 countries. For more information about Autodesk Authorized Training Centers, contact atc.program@autodesk.com or visit the online ATC locator at http://www.autodesk.com/atc.

Autodesk Courseware

Autodesk publishes many courseware titles each year for users at all levels to improve their productivity with Autodesk software. The preferred training materials of Autodesk partners, these books are also well-suited for self-paced, standalone learning. All courseware simulates real-world projects with hands-on, job-related exercises. Autodesk Official Training Courseware (AOTC) is developed by Autodesk. Autodesk Authorized Training Courseware (AATC) is developed by Autodesk partners, including titles in a growing number of languages. Autodesk Official Certification Courseware (AOCC) teaches the knowledge and skills assessed on the Certification examinations. Visit http://www.autodesk.com/aotc to browse the Autodesk Courseware catalog.

Autodesk Certification

Gain a competitive edge with your career by obtaining Autodesk Certification, validating your knowledge and skills on Autodesk products. Autodesk provides an end-to-end solution for assessing your readiness for certification, preparing for certification, and obtaining certification. For more information on Autodesk Certification, visit http://www.autodesk.com/certification.
e-Learning

Autodesk e-Learning for Autodesk Subscription customers features interactive lessons organized into product catalogs. Each lesson is 20-40 minutes in length and features hands-on exercises, with an option to use a simulation or the software application. You can also use an online evaluation tool that identifies gaps in skills, determines what lessons will be most helpful, and gauges learning progress.

If you are a member of Autodesk subscription, you can access e-Learning and other subscription services from within your Autodesk product. For more information about Autodesk subscription resources, visit http://www.autodesk.com/subscription.

Raster Design Home Page

If you have an Internet connection, then you can find additional information about Raster Design on the Raster Design home page. The home page includes information about technical support, purchasing information, and how to access the Raster Design news group.

To access the Raster Design home page

➤ Select Raster menu ➤ Raster Design Home Page.

or Click the icon on the Raster Design toolbar, or open http://www.autodesk.com/rasterdesignuser from your Web browser.

Raster Design Basics

You can use Raster Design to edit and manage raster data. Raster data is a series of dots or pixels that form an image. This type of data is produced when you scan a paper drawing, blueprint, or photograph.

There are three main types of raster images:

Bitonal Two-color line drawings, usually black and white, also called binary

Grayscale Images with several different shades of gray, such as scanned black and white photographs
Color  Images with multiple colors, such as color aerial photographs

Vector data, on the other hand, is created by mathematical equations that generate lines, arcs, and other AutoCAD objects. Vector data typically consists of points that define precise geometric shapes. This type of data is produced when you draw objects in AutoCAD.

If you use AutoCAD without Raster Design, you can insert raster images into a drawing and modify their position, scale, and display values such as brightness and contrast. However, you need a raster editing program like Raster Design to do any of the following:

- Permanently edit the raster data of your images
- Insert images that include correlation data into a drawing
- Save images to another format
- Export images to create external correlation files

In Raster Design, image frames are defined as AutoCAD objects, which means you can assign a frame to a layer and change its color.

In this documentation, the term raster entities refers to the lines, arcs, and circles, including text, that make up a bitonal raster image.
Converting raster entities to vector makes it easier to modify a drawing and can reduce the total file size of your project. After conversion, you can edit the vector entities using AutoCAD commands. To convert raster to vector, you can use the Raster Design vectorization tools (VTools).

With raster entity manipulation (REM) commands, you can edit raster entities and regions with vector-like precision. You can create a selection set of a raster area or raster entities, then move, copy, or delete the selection set using native AutoCAD commands.

### When to Use Raster Design

You can use Raster Design for the following tasks:

- Insert images that respect correlation information from various sources
- Process images to permanently adjust brightness and contrast, convert color images to grayscale, and convert color and grayscale images to bitonal format
- Compose an image from several bands of satellite data or from a digital elevation model (DEM) to display particular features of the terrain, such as the degree of slope or the presence of vegetation
- Trace the raster lines, arcs, circles, or contours on a bitonal raster image, converting the raster geometry to vectors interactively or semi-automatically
- Modify the display order of images
- Merge two or more raster images
- Remove parts of images
Merge vectors into a raster image
Read, save, and export images to different names, locations, and formats
Move, delete, and copy bitonal raster entities and areas on raster images using the raster entity manipulation (REM) commands
Make vector additions to raster entities by using raster snap modes to snap the new vectors to existing raster entities
Select a color in an image and make it transparent
Clean up speckles and other visual defects in raster images such as blueprints and floor plans
Correct distortions in images

Who Should Use Raster Design?
Anyone who wants to edit, manage, and correlate raster images with AutoCAD can benefit from the capabilities of Raster Design.

Architects
To incorporate photographs and old hand-drawn plans into new vector data for planning and presentation purposes before remodeling, renovating, or doing historic reconstruction.
To show a project in context with its terrain using DEM imagery.

Cartographers
To take advantage of real-world coordinate support. When running on the AutoCAD GIS-based desktops, such as AutoCAD Land Desktop, and AutoCAD Map 3D, Raster Design gives you the ability to perform coordinate transformations.

Environmental specialists
To generate groundwater contours, locate wells, display the health of vegetation, plot contamination values, and use geo-referenced data for support of risk assessment.

Geo-exploration specialists and engineers
To use remote sensing data for exploration planning, strata mapping, and geotechnical applications.

Land planners
To analyze land drainage or to integrate imagery, maps, and terrain models into base maps that depict change analysis and land use.
Mechanical engineers
To easily update scanned drawings using REM commands and VTools.

Municipal and state mapping agencies
To use scanned tax maps and ordinance surveys as references for detailing city systems and GIS tasks.
To display land use from multispectral remote sensing data.

Photogrammetric and Remote Sensing Firms
To use many image formats, including GeoTIFF and GeoSPOT.
To use correlation commands to integrate images into base maps.

Resource managers
To use multispectral remote sensing data, scanned forest cover-type maps and soil maps, and georeferenced data and images for impact studies in forestry, soil science, hydrology, and wildlife management.
To use scanned forest cover-type maps and soil maps, and georeferenced data and images for impact studies in forestry, soil science, hydrology, and wildlife management.

Surveyors
To perform deed analysis using images for photogrammetric control by using the vectorization tools to convert raster to vector.

Image Types and Color Maps
With Raster Design, you can insert several types of images into a drawing, and display them in various ways. The color map provides the main source of display control. Raster Design recognizes the inserted image type and provides a default color map. Later, you can edit the color map, or with some image types, create a new insertion with a different type of color map.

Image data attributes

<table>
<thead>
<tr>
<th>File Type</th>
<th>Data Structure (bits/pixel)</th>
<th>Default Color Map</th>
<th>Insertion Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bitonal</td>
<td>1 bit</td>
<td>Bitonal</td>
<td>Bitonal</td>
</tr>
<tr>
<td>Grayscale</td>
<td>4 or 8 bit</td>
<td>Image Adjust</td>
<td>Grayscale</td>
</tr>
<tr>
<td>Index Color</td>
<td>8 bit (256 colors)</td>
<td>Image Adjust</td>
<td>Index Color</td>
</tr>
<tr>
<td>True Color</td>
<td>24 or 32 bit</td>
<td>Image Adjust</td>
<td>True Color</td>
</tr>
</tbody>
</table>
The different color maps have the following attributes:

- **Bitonal color map** controls the color assigned to the linework (foreground color) and background of a bitonal image.

- **Image adjust color map** uses the AutoCAD Image Adjust dialog box to control values for brightness, contrast, and fade.

- **Palette color map** has many options available for interpreting and displaying the data. For example, you can display surface elevation, slope, or aspect, choose the number of data ranges, and assign a color to each range.

- **Band assignment color map** specifies which data bands to display and which color channel (red, green, or blue) to use for each one. By assigning bands to channels in particular ways, you can create false color images for analytic purposes, such as the display of vegetation or water features.

For related information, see Editing Color Maps on page 62, and Supported Image Formats on page 79.

### Minimum Requirements

**NOTE** For complete instructions about installing AutoCAD Raster Design, see the Software Installation Guide.

To run properly, AutoCAD Raster Design 2012 requires a minimum of the following hardware and software.
Software Requirements

One of the following operating systems is required:

32-bit

- Windows 7
- Windows Vista Enterprise
- Windows Vista Business
- Windows Vista Ultimate
- Windows Vista Home Premium
- Windows XP Professional, Service Pack 2
- Windows XP Home, Service Pack 2

64-bit

- Windows 7
- Windows Vista Enterprise
- Windows Vista Business
- Windows Vista Ultimate
- Windows Vista Home Premium
- Windows XP Professional

**NOTE** It is recommended that non-English language versions of AutoCAD Raster Design be installed on an operating system with a user interface language that matches the code page of the AutoCAD Raster Design language. A code page provides support for character sets used in different languages.

One of the following AutoCAD® 2012–based products is required:

- AutoCAD® 2012
- AutoCAD® Architecture 2012
- AutoCAD® Civil 3D® 2012
- AutoCAD® Electrical 2012
Hardware Requirements

Recommended processor: Intel® Pentium® IV.

You should have 200 MB of disk space available in addition to the minimum system requirements of AutoCAD 2012, or the AutoCAD 2012–based product upon which AutoCAD Raster Design is installed.

Network Installation of AutoCAD Raster Design

System administrators planning to install AutoCAD Raster Design on a network must have TCP/IP installed and functioning on the computers that are running AutoCAD Raster Design.

For more information about installing Raster Design on a network, see the Network Administrator’s Guide.

Starting Raster Design

Raster Design runs seamlessly with the AutoCAD-based products on your computer. The Raster Design setup program automatically creates an icon for each AutoCAD-based program that you can use to start both Raster Design and the AutoCAD-based host program.

To start a Raster Design program

Steps

1. To initialize the host product and Raster Design, select the Raster Design icon. If Raster Design is correctly installed, an Raster menu appears in the host product.
To start a Raster Design program

2. Click Raster menu ➤ Insert to insert an image, or Raster menu ➤ Options to configure Raster Design.

Exiting Raster Design

When you have completed your editing session, either exit the AutoCAD-based host program, or start a new editing session by opening an existing drawing or creating a new drawing.

When you exit, you are prompted to save your drawing and any edits you have made to the images. Any image correlation data, such as insertion point, scale, and rotation, is saved in the drawing file. Any edits you have made to the images are saved in the image files.

NOTE Use the Export (export) command if you want to save the correlation information along with the image file.

You can either save edits you made to your images, or discard unsaved edits by skipping over a specific image you edited. When you save or exit a drawing, the Save Image dialog box is displayed with images you have edited. You can use these options to save all edited images, skip all edited images, or save selected images before exiting.

Configuring Raster Design

The options in the Raster Design Options dialog box control the major settings for Raster Design, such as image paths, and the default correlation information for new images. These settings affect the entire drawing and all images that are inserted into the drawing.

To access the Raster Design Options dialog box, click Raster menu ➤ Options, or type ioptions on the command line.
The Raster Design Options dialog box has the following tabs. For more information about any of these settings, click the tab, then click Help.

- **Paths** sets the path for correlation files and the AutoPaste feature.
- **User Preferences** controls image detachment, message display options, and the mouse settings. This tab also allows you to set default Startup options.
- **Feature Settings** sets the option to save a thumbnail with your image. This tab also controls locking settings, Remove Under settings, and the rub/crop line width.
- **Image Defaults** sets the default correlation data for an image: insertion point, scale, rotation, density, and vertical units. These values are used if correlation data is not supplied with an image.
- **New Image** sets the default values for the creation of a new image, including image properties and default color type.
- **Vector Merge** sets the default behavior for future vector merge operations, including expanding an image and respecting the display order.
REM sets the default properties for REM Objects, including clipboard settings and REM Object color.

Raster Entity Detection sets the default values for detecting various types of raster geometry using either single-pick or multi-pick methods.

Image Mask sets the default property values for future image masks, including turning the mask on and off, showing how the mask affects the images in the drawing, and defining the mask boundary.

VTools General sets the default options for most of the vectorization tools. In the vector separation table here you can assign layers and polyline widths based on the width of the raster being traced.

VTools Follower sets the default options for the follower tools. These tools can follow raster contours or polylines and vectorize them using a semi-automatic process.

Using Raster Design Commands

You can access the Raster Design commands from the Raster menu, the shortcut menu, the toolbar, or the command line. We suggest that you experiment with all options to determine which you prefer.

Raster Menu

All Raster Design menu options are located on the Raster menu. The following chart outlines the functions you can access through this menu, and provides cross-references to sections in this book for more information.

Raster menu options

<table>
<thead>
<tr>
<th>This option...</th>
<th>Performs this function.</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Displays the New Image dialog box, where you can define the frame and properties for an image you want to create. In this manual, see Creating a New Image on page 36.</td>
</tr>
<tr>
<td>Insert</td>
<td>Displays the Insert Image dialog box that is used to insert images into your current AutoCAD drawing. Also provides access to the correlation function for precise placement of an image. In this manual, see Inserting Images on page 27.</td>
</tr>
</tbody>
</table>
**Raster menu options**

<table>
<thead>
<tr>
<th>This option...</th>
<th>Performs this function.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save, Save As</td>
<td>Saves an image to another file name, location, or file type, saves an image without saving the drawing. In this manual, see Saving Images on page 34.</td>
</tr>
<tr>
<td>Export</td>
<td>Exports an image to a different file format, or exports correlation data associated with the image. In this manual, see Exporting Images on page 35.</td>
</tr>
<tr>
<td>Image Embed</td>
<td>Saves a bitonal image within the drawing to simplify file management. In this manual, see Saving Images on page 34.</td>
</tr>
<tr>
<td>Capture</td>
<td>Saves the current displayed version of image data, producing an image of convenient size. In this manual, see Saving Images on page 34.</td>
</tr>
<tr>
<td>Correlate</td>
<td>Correlates your image by matching, moving, scaling, or rubber-sheeting. In this manual, see Correlating Images on page 31.</td>
</tr>
<tr>
<td>Manage</td>
<td>Displays the Image Manager, which shows information about insertions, images, and color maps. You can do many tasks here, such as insert new images, change the display order of insertions, erase an image, zoom to an image, assign a different color map, and review metadata. In this manual, see Image Manager on page 20.</td>
</tr>
<tr>
<td>Cleanup</td>
<td>Fixes problems with documents that have been damaged or distorted by reproduction processes. You can deskew, despeckle, invert, mirror, touchup, or adjust the bias of an image. In this manual, see Correcting Images on page 40.</td>
</tr>
<tr>
<td>Image Processing</td>
<td>Enhances the appearance of your image, removes defects, converts an image to a different type, adjusts colors, and assigns color palettes. In this manual, see Correcting Images on page 40.</td>
</tr>
<tr>
<td>Raster Entity Manipulation</td>
<td>Edits bitonal, color, and grayscale raster data. Options are provided to select raster entities and then vectorize, edit, or remove them. In this manual, see Manipulating Raster Entities on page 47.</td>
</tr>
</tbody>
</table>
# Raster menu options

<table>
<thead>
<tr>
<th>This option...</th>
<th>Performs this function.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mask</td>
<td>Creates a mask, which is a selected area within the image. In this manual, see Masking Images on page 39.</td>
</tr>
<tr>
<td>Crop</td>
<td>Crops an image to remove unwanted areas. Options are provided for cropping a line or regions of various shapes. In this manual, see Rubbing and Cropping Images on page 56.</td>
</tr>
<tr>
<td>Remove</td>
<td>Erases or rubs raster entities, such as lines, circles, arcs, or rectangles. In this manual, see Rubbing and Cropping Images on page 56.</td>
</tr>
<tr>
<td>Merge</td>
<td>Merges images or vector data, and selects raster pen widths. In this manual, see Merging Vectors into Raster on page 70.</td>
</tr>
<tr>
<td>Vectorization Tools</td>
<td>Converts raster arcs, circles, texts, lines, polylines, rectangles, or contours to vector format. In this manual, Vectorizing Raster Entities on page 44.</td>
</tr>
<tr>
<td>Text Recognition</td>
<td>Converts raster text to AutoCAD text. In this manual, see Converting Raster Text on page 47.</td>
</tr>
<tr>
<td>Raster Snap</td>
<td>Sets the snapping mode, which controls whether your cursor moving within an image automatically jumps to raster entity endpoints, intersections, or other significant points. In this manual, see Snapping to Raster Entities on page 42.</td>
</tr>
<tr>
<td>Toggle Frames</td>
<td>Changes the visibility of the image frame.</td>
</tr>
<tr>
<td>Toggle Quick Bar</td>
<td>Changes the visibility of the Quick Bar.</td>
</tr>
<tr>
<td>Raster Data Query</td>
<td>Displays the Raster Data Query dialog box, which interactively displays data about the pixel under the cursor.</td>
</tr>
<tr>
<td>Options</td>
<td>Displays the Raster Design Options dialog box where you can configure Raster Design. In this manual, see Configuring Raster Design on page 14.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays the AutoCAD Raster Design User Guide in Help.</td>
</tr>
</tbody>
</table>
**Raster menu options**

<table>
<thead>
<tr>
<th>This option...</th>
<th>Performs this function.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raster Design Home Page</td>
<td>Opens the Raster Design home page on the Internet, if you have an internet connection and browser: <a href="http://www.autodesk.com/rasterdesignuser">http://www.autodesk.com/rasterdesignuser</a></td>
</tr>
<tr>
<td>About Raster Design</td>
<td>Displays Raster Design licensing information.</td>
</tr>
</tbody>
</table>

**Toolbars**

Raster Design provides more than a dozen toolbars that you can use to access commands quickly while you work. The Raster Design Toolbar is the largest one, and includes several submenus that can be displayed as separate toolbars. When you pass the cursor over a tool icon, a tooltip shows the name of the tool. More detailed information about a tool, such as the equivalent command-line command, is displayed on the AutoCAD status bar at the bottom of the screen.

To display the menu of available toolbars, right-click an open AutoCAD toolbar. You can open any other toolbar from the shortcut menu.
Command Line

You can run most Raster Design commands by entering their names on the command line. Many Raster Design commands start with the letter i. For example, to run the histogram command, enter ihistogram on the command line.

For a detailed list of all Raster Design commands, see Command Summary on page 83 in this manual.

For each topic described in Help, the menu path for the command is listed as well as the command-line equivalent.

Image Manager

The Image Manager toolspace displays the structure of image data associated with a drawing. Within this dialog you can manage image files, change their display order or their active path, edit color maps, and export images to other locations. To access the Image Manager toolspace, click Raster menu ➤ Manage, or enter imanage.
The Image Manager toolspace has two views that allow you to separately control attributes for image insertions and image data. In each view, you can select objects and right-click to inspect their properties and choose various editing tasks.

The Image Insertions view is display oriented. It is ideal for managing image insertions and their color maps. If your drawing contains more than one insertion of an image, the Image Manager numbers the insertions. For example, if there are two insertions of cadplot.tif in your drawing, then you would see cadplot and cadplot:1 listed.

The Image Data view is more data-centric, as shown in the figure. Here we see two image data definitions on the left (Airport and Contour), with their subordinate band groups (Truecolor and Bitonal) and color maps (RGB and BIN). The image insertions are shown subordinate to their color maps. In this example, each insertion uses the same name as its parent data definition. This view is ideal for creating new insertions and working with image data. If the drawing contained multiple insertions of the Airport image, the Airport branch of this tree view would show a separate color map and insertion object for each one. The image listed at the top of the Image Manager toolspace is at the top of the display order. The image listed last is underneath all the others. To modify this order, drag the names of the images up or down in the list.
You can also use the AutoCAD DRAWORDER command to modify the display order.

Because images are also AutoCAD entities, an image that you edit appears to be placed on top of other images and vectors, even though the image display order has not actually been changed. Use the AutoCAD REGEN command to restore the images and vectors to their correct order.

## Using AutoCAD Commands

AutoCAD imaging commands and Raster Design commands are fully compatible. The primary differences are their image editing capabilities and the methods they provide to insert, manage, and correlate images.

### Imaging Commands

AutoCAD has basic imaging commands you can use to insert images, clip images, and adjust image appearance.

<table>
<thead>
<tr>
<th>Use this AutoCAD command...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>IMAGE</td>
<td>Attach, detach, load, reload, and unload images.</td>
</tr>
<tr>
<td>IMAGEADJUST</td>
<td>Adjust the brightness and contrast of an image, and fade the image (display-only adjustments).</td>
</tr>
<tr>
<td>IMAGEATTACH</td>
<td>Attach (or insert) images.</td>
</tr>
<tr>
<td>IMAGECLIP</td>
<td>Clip an image so that only a selected polygonal area of the image is displayed.</td>
</tr>
<tr>
<td>IMAGEQUALITY</td>
<td>Change between high and draft display modes.</td>
</tr>
<tr>
<td>IMAGEFRAME</td>
<td>Turn frames on and off.</td>
</tr>
<tr>
<td>TRANSPARENCY</td>
<td>Turn transparency on and off.</td>
</tr>
</tbody>
</table>

**NOTE** AutoCAD commands are shown in UPPERCASE. Raster Design commands have an initial capital letter, for example, Histogram. When you enter a Raster Design command on the command line, the letter ‘i’ precedes the command name.
The next sections describe the differences between AutoCAD imaging commands and Raster Design commands.

Image Editing

Using the AutoCAD imaging commands, you can modify image display values such as brightness and contrast, and you can clip an image so that only part of the image is displayed in the drawing. However, these adjustments affect only how the image appears in your drawing. You cannot use AutoCAD by itself to permanently edit the image pixels.

Raster Design was designed to work with AutoCAD so that you can permanently edit your images. For example, if you make adjustments to the brightness and contrast of an image using the Raster Design Histogram (ihistogram) command, you can save the edits to the image file itself. Then, whenever you open a drawing that contains that image file, the image appears with the correct brightness and contrast values.

If, on the other hand, you use the AutoCAD IMAGEADJUST command to edit the Image Adjust color map and you have the same image inserted into other drawings, you must repeat the same changes to each insertion of the image in all drawings.

Image Insertion and Correlation

Images you insert using the AutoCAD IMAGE command are completely compatible with images you insert using the Raster Design Insert (iinsert) command. For example, if you insert images using the Raster Design Insert command and then save the drawing, the images are displayed and correlated if you open the drawing using AutoCAD without Raster Design.

AutoCAD stores only one definition of each image you insert into a drawing, even if you have multiple copies of the same image in the drawing. The definition is referred to as the image data definition, while each copy is referred to as an image insertion. You can manage the data definitions and insertions in your drawing with the Image Manager toolspace. For more information, see Image Manager on page 20.

Unlike AutoCAD, Raster Design respects correlation from various sources. Whenever you insert an image using Insert, Raster Design searches for correlation data associated with that image. Then, you can decide which source to use. These correlation sources include correlation that was saved in the image file, resource files, world files, and the defaults that you specify in the
Raster Design Options dialog box. For more information, see Correlating Images on page 31.

Using Other AutoCAD Commands on Your Images

Because image frames are treated as AutoCAD objects, you can modify your images using standard AutoCAD commands, such as MOVE, COPY, ROTATE, and SCALE.

Using AutoCAD grips, you can select image frames and vectors and then choose an editing command. You can edit both raster images and vector objects at the same time by including both in your selection set.

NOTE You can use the AutoCAD UNDO command for up to ten Raster Design image edits. This limit applies to edits that actually change raster data, not to display-only changes. Some of the operations affected by this limit are REM, Histogram, Remove, Crop, Palette Manager, and Rubbersheet.

Some frequently used AutoCAD commands:

<table>
<thead>
<tr>
<th>Use this AutoCAD command to...</th>
<th>Do this.</th>
</tr>
</thead>
<tbody>
<tr>
<td>REGEN</td>
<td>Restore the correct display order of images. When you edit an image, the image is placed on top of any other images or vectors in your drawing. Use the AutoCAD REGEN command to restore the images to their correct order.</td>
</tr>
<tr>
<td>LAYER</td>
<td>Control the display of images. You can insert each image on a different layer and then use the LAYER options to turn the image layers on or off, freeze them, change their colors, or lock them to prevent the images on them from being edited.</td>
</tr>
<tr>
<td>ZOOM and PAN</td>
<td>Zoom to images and pan across images.</td>
</tr>
<tr>
<td>UNDO</td>
<td>Undo the effects of a Raster Design command.</td>
</tr>
<tr>
<td>DVIEW</td>
<td>Rotate the UCS to any degree to view the images at a different angle.</td>
</tr>
</tbody>
</table>

NOTE You cannot edit an image if you use the VPOINT command to change the drawing viewpoint to anything other than 0,0,1.
<table>
<thead>
<tr>
<th>Use this AutoCAD command to...</th>
<th>Do this.</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLOT</td>
<td>Plot an image.</td>
</tr>
<tr>
<td>SCALE</td>
<td>Scale a REM object or insertion.</td>
</tr>
<tr>
<td>DYNMODE</td>
<td>Set the Dynamic Input variable to specify no display (0), pointer input (1), dimensional input (2), or both (3).</td>
</tr>
<tr>
<td>OSNAP</td>
<td>Snap to image frames and REM objects.</td>
</tr>
</tbody>
</table>
General Concepts

This chapter explains how to work creatively and efficiently with raster image data in your drawings. The process begins with inserting one or more images, at which time you can modify some essential display characteristics. Later, you can clean up or edit the images to suit your needs. When you save the images, you can choose whether to modify the original versions and whether to link the images to your drawing.

Inserting Images

You can insert any number of raster images into an AutoCAD drawing. Each image is placed in a frame, and a link is created between the drawing and the image file.

When you click Raster menu ➤ Insert (or enter iinsert on the command line), the Insert Image dialog box is displayed. Here you can preview the image and information such as file type, color depth, and density. The column of folders along the left side of the Insert Image dialog box is called the Places List. It contains shortcuts to local folders, such as your Favorites folder or My Documents folder.
You can open image files from the Internet in several ways:

- Click the Search The Web icon at the top of the dialog box to display the AutoCAD Web browser, with which you can specify an Internet location and select an image to insert.

- Click the Buzzsaw icon in the Places List to access projects hosted on Buzzsaw.com.

- Click the FTP icon to browse FTP sites and select an image to insert.

An inserted image must be correlated in the drawing. Correlation is simply a means of positioning the image using known coordinates. If you want to display the image, you must also assign it a color map, which specifies how to use the available colors to show image data.

You can configure your inserted image in three different ways during the insertion process:

- Quick Insert applies automatic correlation and color mapping during image insertion. No additional options are required with this choice.

- Insertion Wizard is recommended for the new Raster Design user, as it proceeds through the insertion process step by step.
Insertion dialog is intended for intermediate and experienced users, as it presents the insertion options on separate tabs.

During insertion, you can change some attributes, such as the image scale, the color of the image frame, and the foreground color of bitonal images.

The following sections explain the additional concepts involved in image insertion.

Using Color Maps

Use a color map to assign colors to an image for display purposes. With a traditional single-image file such as a photo or drawing, Raster Design assigns a default color map and adds the image to the display.

Use a color map to assign colors to an image for display purposes. With a traditional single-image file such as a photo or drawing, Raster Design assigns a default color map and adds the image to the display. With a digital elevation model (DEM) or multispectral file, you can choose which data to display and how to display it.

A DEM file uses a palette color map. If you choose to edit an existing color map definition or create a new one, you use the Palette Color Map Definition dialog box.
Using Raster Design, you can display a DEM land surface, color coded by elevation, degree of slope, or aspect (direction of slope). Specify which of these attributes to display, then set the number of value ranges, the color for each range, and the strategy for distributing the ranges across the full extent of the data values.

When you insert a multispectral image, you create a color map by assigning an image band to each color channel (red, green, and blue). Some combinations of bands and channels create special-purpose images for highlighting vegetation, water temperature, and other land features. You can also turn off individual channels.
Correlating Images

You correlate an image by positioning it within the AutoCAD coordinate system with correct scale, rotation, and coordinates. You can specify correlation details for an image at the time of insertion or later. You can also use options such as Scale, Displace, and Rubbersheet to correct distortions in the image.

One way to correlate an image on insertion is to use an existing correlation source. Depending on the type of image you are inserting and whether or not a resource file or a world file exists for it, you may see the following sources listed:

- Image File: For certain types of images, correlation data can be saved as part of an image file. These file types include RLC, IG4, IGS, GeoTags in GeoTIFF, or HDR File in SPOT.

- Resource File: Created by the Raster Design Export command or previous versions of Raster Design. Resource files have a .res file extension.

- World File: Created by the Raster Design Export command for a variety of image formats. World file extensions vary according to file type, but all end in the letter w. Examples: BMP - .bpw, TIFF - .tfw.

- Image Defaults: The values you set in the Raster Design Options dialog box.

The information displayed on the Pick Correlation Source dialog box reflects the values stored in the correlation source you have chosen.

With Raster Design, you can insert several images at the same time. When you select more than one image to insert, the default correlation information is used to automatically position the images. This option is very useful when you have a group of images, such as tiled quadrant sheets, that have correlation data stored with the images.
Selecting Images

The following table explains two methods for selecting images:

<table>
<thead>
<tr>
<th>Action</th>
<th>Frame Selection Method</th>
<th>Shift + Left-Click Method</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Click the frame.</td>
<td>Press Shift while clicking the image(s) with the left button of your mouse.</td>
</tr>
<tr>
<td></td>
<td>Use an AutoCAD crossing window to select the frame edge.</td>
<td></td>
</tr>
<tr>
<td>Result</td>
<td>AutoCAD grips appear at the corners of the image frame.</td>
<td>If you click more than one image, the Image Select dialog box is displayed, where you can select the images to include. AutoCAD grips appear at the corners of the selected image frame.</td>
</tr>
<tr>
<td>Advantages</td>
<td>You can do this either before or after selecting a command.</td>
<td>You can do this when image frames are turned off, or when the image frame is outside your active window.</td>
</tr>
<tr>
<td>Disadvantages</td>
<td>The frame must be visible in the drawing.</td>
<td>You must do this before selecting a command.</td>
</tr>
</tbody>
</table>

Rubbersheeting an Image

You can use the Rubbersheet option to

- Fix distortions in aerial photography caused by aircraft tilt, camera distortion, and unevenness of terrain.
- Save money on orthophotography when absolute accuracy is not required.
- Correct most of the distortions in an image resulting from parallax.

Rubbersheeting works by transforming an image so that points you specify in the image match corresponding points in the drawing as closely as possible. These matched points, consisting of a source point in the image, and a destination point in the drawing, are known collectively as control points. Enter control points by picking them from the image, or use the Grid tool to
make a grid of destination points that you match to their corresponding source points.

NOTE If you are using AutoCAD Land Desktop, you can substitute COGO points by entering .p, .g, or .n when Raster Design prompts you to enter destination points. For more information see the Help topic “Snapping to COGO Points.”

Raster Design provides two methods for transforming the image:

- Triangular method uses the control points you enter to triangulate the image, then performs a series of small transformations on those triangular areas. The area to be transformed is called the convex hull, and is defined by the outermost destination points. Image data outside the convex hull is discarded.

- Polynomial method uses the control points to perform a single transformation based on the entire image. However, the polynomial method does not always result in perfectly matched control points.

NOTE Rubbersheeting is best suited for making minor transformations to an image. For best results, start with an accurate network of survey control points, then use match and scale before rubbersheeting to get the image as close to the desired results as possible. You should have a good spread of control points over the entire image. Where you do not want the image to move, you can set anchor points.
In the Rubbersheet – Set Control Points dialog box, add control points to your image or import a control point file to apply to your image. After the points are added to your image, click Export to save the control point set.

**Transforming the Coordinate System**

If AutoCAD Raster Design is installed on a geographic application, such as AutoCAD Map 3D or AutoCAD Civil 3D, you can transform the coordinate system of an inserted image to match the coordinate system of the drawing. Several types of coordinate transformation are available:

- **3-point affine** transform enables Raster Design to handle non-editable data types.
- **4-point rubbersheet** transform is an approximate transformation that uses four control points.
- **True** coordinate transformation applies to each pixel in the image, creating a very accurate representation of the surface.

**Saving Images**

You can save an image in several ways, depending on your needs:

- **File menu ➤ Save.** Saves the drawing and prompts you to save any images you have edited. Because of the link between the drawing and the image files, the image data is not stored in the drawing file, but in a separate file. You have the option of either saving each edited image individually, or saving all of the edited images in your drawing. You can skip over an image if you do not want to save the changes you made.

- **Raster menu ➤ Save.** Saves an image without saving the drawing file. You can use this command to save more than one image at a time.

- **Raster menu ➤ Save As.** Saves an image and lets you change the name, file type, or location. Using this command, you can convert a read-only image to a file that can be edited.

- **Raster menu ➤ Image Embed.** For bitonal images only, saves the image within the drawing. This command simplifies file management when transmitting or archiving drawings and images.
Raster menu ➤ Capture. Saves a “snapshot” of a displayed image, including the effects of color maps, clips, masks, and rotation. This command is ideal for saving an image created from a multispectral data set or digital elevation model (DEM).

Raster menu ➤ Capture. Saves a “snapshot” of a displayed image, including the effects of color maps, clips, masks, and rotation.

Exporting Images

Export an image either for use in another graphics application, or to save the image correlation data for later use.

When you save an AutoCAD drawing file that contains a raster image, the image correlation data is saved in the drawing file, not in the image file itself. If you want to insert the image into another drawing and use the same correlation data, save correlation data with the image.
When you export an image (Raster menu ➤ Export), you can save correlation data in one of three locations:

■ a resource file, for use with Raster Design
■ a world file, for use with other image formats
■ the image file itself

Saving correlation data to the image file is possible only with some image types. You can export correlation data to a world file without exporting the associated image. For more information on file types, see Correlating Images on page 31.

When you export an image, using a different image name, file format, or file location, you can maintain the link between the drawing and the exported image if you want the new image file to replace the one that is currently linked to the drawing.

You can insert a read-only image into a drawing and then save it to a read-write format using the Export, Capture, or Save As options. However, only the Export option saves the image correlation information.

When you export rotated images, Raster Design gives you the option to “burn in” the rotation, which means that the image retains its rotated position, but the rotation value is set to zero.

### Creating a New Image

You can create a new blank image to contain an image created by editing another image or merging two or more images. To create a new image, you first define an image frame, then set properties in the New Image dialog box.
After you have created a new image, you must save it to establish a link between the drawing and the image file. To define the properties for more than one new image, use the New Image tab on the Raster Design Options dialog box.

Setting Image Properties

You can control many aspects of image appearance by setting properties. These include AutoCAD properties and Raster Design properties.

AutoCAD Properties

View the AutoCAD properties of an image either by right-clicking the image or right-clicking the image object in the Image Insertions view of Image Manager. The main AutoCAD property types are as follows:

- General. Color, layer, and line settings. The color setting controls the foreground color of a bitonal image or the frame color of a color or grayscale image.
- Image Adjust. Settings for brightness, contrast, and fade values.
- Geometry. Correlation settings, including scale, rotation, and X, Y, Z values for the origin.

For more information, see AutoCAD Help.
Raster Design Properties

View the Raster Design properties of an image in the item view of Image Manager. The properties shown vary somewhat, depending on image type, what is selected (image data or insertion), and the location (Image Insertions view or the Image Data view) in Image Manager. The main Raster Design property types are as follows:

- **Information.** Image name, type, specifications, and whether the image can be edited and saved.
- **Display Settings.** Image layer, background transparency settings, and whether the image is visible.
- **Correlation.** Scale, rotation, and X, Y, Z values for the origin.
- **Paths.** Include the active path, from where the image was inserted, and the saved path where it is currently being saved.

Setting Background Transparency

You can assign background transparency to a particular color, then turn background transparency on or off. In bitonal images, the transparent color is always the background color. In color and grayscale images, you can choose any available color or shade for the transparent color. When background transparency is on, all image pixels drawn in the transparent color become transparent. When background transparency is off, these pixels assume their normal opaque color.

The following illustration shows how to use background transparency settings to control the visibility of an underlying image.
Background transparency is on for the parcel map. The aerial photograph is visible.
Background transparency is off for the parcel map. The aerial photograph is covered.

The transparent color has three uses:

- You can make all pixels of a specified color transparent when you turn on background transparency.
- When you use Remove or Crop, the removed (rubbed) or cropped areas are displayed in the transparent color. For example, if you choose blue as the transparent color, all rubs are displayed in blue. If you turn on background transparency for that image, the rubbed areas become transparent. For more information, see Rubbing and Cropping Images on page 56.
- When you merge two images together, any blank space is filled with the transparent color of the destination image.

**Masking Images**

You can use an image mask to display and plot a subset of the images in your drawing. An image mask conceals parts of the images that are outside the mask boundary. The mask boundary is a rectangular or polygonal AutoCAD object that you can move, stretch, scale, and erase like any other AutoCAD object.

In the following illustration, a polygonal mask was created with the Hide Image(s) option.

The third illustration shows the results of using the Show Image Frame(s) option.
A Raster Design mask affects all the images in a drawing, but it does not permanently modify the images. You can resize the mask or turn it off to redisplay all the images. The AutoCAD IMAGECLIP command works like a mask, but affects only one image. You can convert a mask to individual image clips.

**Correcting Images**

You can use several commands on the Raster menu to permanently edit your images.

Use the Cleanup submenu tools to correct image errors. You can deskew (rotate), invert (reverse the colors), or mirror (flip) an image. You can also despeckle an image to remove spots, touch up linework, or change the bias, stretching the image into the correct shape.

Use the Image Processing submenu to improve the visual quality of an image. You can change pixel density or color depth, and apply filters. Convolving filters can either smooth or sharpen image details in grayscale images. The Histogram can adjust brightness, contrast, and image tone for color or grayscale images. Use it to change a limited range of tones, leaving others unaffected, and to change an image to grayscale or bitonal.

For bitonal images, you can use bitonal filters in conjunction with cleanup commands, such as Despeckle and Deskew.

The following bitonal filter types are available:

- **Smooth** removes unwanted pixels from the edges of raster objects and fills holes in raster lines.

- **Thin** trims raster objects by one pixel per pass in the direction you specify.
Thicken widens the edges of raster objects by one pixel per pass in the direction you specify.

Separate works when raster lines are partially merged, converting them into two distinct lines.

Skeletonize thins all raster data to one pixel in thickness. After you thin your raster data to a one pixel width, you can run the Thicken filter to achieve a uniform width.

Managing the Image Palette

For eight-bit images (256 colors or shades of gray), you can use the Palette Manager to change, condense, or combine colors, assign background transparency, or convert grayscale images to paletted color images. You can also use it to analyze the image palette and display it in different ways, such as by color frequency or luminance. Apply standards by importing and exporting palettes.
The Palette Manager displays the image palette in two ways:

- The color table displays the palette as an array of color buttons. Pausing the cursor over a color button displays data for that entry. Click a single color to select it, or select multiple colors for tasks such as combining colors.

- The list view provides numeric data for each entry in the palette, such as RGB color values, frequency, and background transparency.

**Snapping to Raster Entities**

Raster snap modes make it easy to select exact positions on bitonal raster entities. Raster snap modes work like AutoCAD Object Snap modes, except that they snap to raster entities instead of to vector objects.

Raster snaps are useful when you want to

- Trace a raster entity with vectorization tools (VTools)
- Select a raster entity to rub or crop
- Select a raster entity to edit with raster entity manipulation (REM) commands

**NOTE** Raster snapping works only with bitonal images.
When raster snapping is on (active), a snap window is displayed around the AutoCAD cursor. The snap window displays the crosshairs over points to which you can snap. You can select one or more snap modes to control whether the cursor snaps to endpoints, corners, and other points.

You can toggle Raster Snap on and off by using the Raster menu ➤ Toggle Quick Bar option.

To access the Raster Snap options, click Tools menu ➤ Drafting Settings (or use the AutoCAD DSETTINGS command), then click the Raster Snap tab.
Vectorizing Raster Entities

Raster Design provides tools to partially automate the process of vectorizing raster entities. Each tool is designed to vectorize a raster geometry type, converting it to the corresponding AutoCAD entity. In many cases, you can convert a raster entity to a vector one with a single pick.

Since vectorizing an image can be time consuming, you should consider your plans for the image before deciding whether or not to vectorize it. If you want to simply archive the image, you do not need to vectorize it. If you want to remove portions of the raster image, you can use the Remove, Crop, and Raster Entity Manipulation (REM) editing commands instead of vectorizing it. If you cannot easily change the image using the above suggestions, or if you need to use the vector data in AutoCAD or another program, you should vectorize the entities.

Vectorization tools work best on bitonal images. In particular, one-pick selection and follower tools do not work with grayscale or color photographs.

There are seven vectorization tools:

■ Line. Converts raster lines to vector lines. This tool uses two basic selection methods: one-pick, which vectorizes a raster line with a single pick, and multi-pick, in which you enter the start and endpoint of the raster line.

■ Polyline. Converts connected raster lines to polylines. Like the line tool, you can use one-pick or multi-pick selection methods.

■ Rectangle. Converts raster rectangles to vector. Select points to define the corners and baseline angle of the rectangle, then Raster Design creates a closed polyline.

■ Circle. Converts raster circles to vector. Select the raster circle using several methods, including one pick.

■ Arc. Converts raster arcs to vector. Select the raster arc using several methods, including one-pick.

■ Text and Multiline Text. Replace raster text with AutoCAD text or multiline text (Mtext).

Vectorization tools can verify and adjust the dimensions of the vector entities you draw, which is important if the raster image you are vectorizing is not completely accurate. For example, after you vectorize a line segment, you can...
check the line length and angle. If they are incorrect, change the dimensions before you create the next line. These review and edit operations can be much easier if you enable AutoCAD's Dynamic Input while vectorizing.

Dynamic Input shows prompts in convenient locations. The figure shows an example of prompts that display the line length and angle as you move the cursor. You can also enter a numeric value for the line length.

Before using vectorization tools, adjust the settings in the Raster Design Options dialog box. Use the options on the VTools General and VTools Follower tabs to customize the behavior and precision of the tools. Optionally, use Vector Separation Options to automatically assign a layer and polyline width to the vectors you create with vectorization tools. You can assign these values based on either raster line width or the elevation of the resulting vectors.

The Follower Tools

A follower VTool can follow raster geometry to vectorize it, but prompts you for input when it reaches a decision point, where it can no longer proceed on its own (for instance, at a raster endpoint or a label). At each decision point, you can provide more information, change course, return to a previous vertex, or stop the follower. Raster Design provides separate follower tools for vectorizing contour lines, polylines, and three-dimensional polylines. For more information, see Using Vector Follower Tools on page 78.

A follower VTool can follow raster geometry to vectorize it, but prompts you for input when it reaches a decision point, where it can no longer proceed on its own (for instance, at a raster endpoint or a label). At each decision point, you can provide more information, change course, return to a previous vertex, or stop the follower. Raster Design provides follower tools for vectorizing polylines. For more information, see Using Vector Follower Tools on page 78.
Using Vector Separation

You can use vector separation options to automatically assign line widths and layers to the vector lines created in the vectorization process. The vector separation options are available on the VTools General tab of the Raster Design Options dialog box.

You can use vector separation as follows:

There are two ways to use vector separation:

- Separate vectors based on the width of the raster lines by using the General tab of the Vector Separation Options dialog box. For example, you can assign thin dimension lines to a separate layer from the thicker object lines. Simply specify two or more ranges of line widths for the raster entities, then assign a layer and polyline width value to each range.

- Assign layer and polyline widths to contours based on their elevation interval using the Contour tab of the Vector Separation Options dialog box. For example, you can set the elevation interval for major contours to 50, and the elevation interval for minor contours to 10. Then if you follow a contour and set the elevation to 450, the resulting vector contour is
assigned to the major layer. If you set the elevation value to 440, the contour is assigned to the minor layer.

Converting Raster Text

The text recognition commands enable you to convert raster text into AutoCAD text or Mtext. These commands are useful for correcting text and making it more legible, or extracting the text for use in other documents. The text recognition engine displays its findings in a verification window where you can make corrections, then insert the new text into the drawing.

Use the Recognize Text option to convert text that is in paragraph form, and use the Recognize Table option to convert text in a table.

Manipulating Raster Entities

Raster Entity Manipulation (REM) enables you to edit raster entities more easily and accurately by temporarily converting them to vector-like objects. After the edit session, you can merge the REM objects back into the raster drawing or move them to a new drawing.

There are three types of REM objects: primitives, regions, and enhanced bitonal regions. You can use each of these object types differently as you edit raster data.

<table>
<thead>
<tr>
<th>REM object</th>
<th>Description</th>
<th>Image type(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primitive</td>
<td>Contains a single raster line, arc, or circle.</td>
<td>Bitonal</td>
</tr>
<tr>
<td>Region</td>
<td>Contains all pixels within a selected region, including parts of entities.</td>
<td>Bitonal, grayscale,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>color</td>
</tr>
<tr>
<td>Enhanced bitonal</td>
<td>Contains complete raster entities within a selected region.</td>
<td>Bitonal</td>
</tr>
<tr>
<td>region</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The following sections show how different selection methods produce different REM objects.
Primitives

This object type is available only in bitonal images. The following example was defined using the Smart selection method for primitive objects. Raster Design detects the circle and defines the entity as a circle primitive object.

After you have defined a REM object, you can use AutoCAD commands to modify it. For more information, see Using AutoCAD Commands on REM Objects on page 51.

Regions

Regions operate on all image types: bitonal, grayscale, and color. On grayscale and color images, regions are hatched to distinguish them from the raster image.

For example, you could select a housing development within an aerial photo as a region object, then use the object to create a street drawing.

Each vertex of a polygonal, rectangular, or diagonal REM region object has a grip. If you move a grip, the entire object moves. If you stretch the grip, the object is scaled.
The following region object includes all the pixels within the selection rectangle: the circle, the portions of the intersecting lines, and the leader line.

Enhanced Bitonal Regions

Use this type of REM object to select several complete raster entities at once. Several selection methods are available to define enhanced bitonal region objects:

- Windows and crossing windows
- Polygons and crossing polygons
- Fences
- Connected entities

You can also choose whether the object includes all the connected pixels within the enhanced bitonal region (connected method) or only the pixels that define a line, a circle, or an arc (smart method).

After you define the enhanced bitonal region object, you can modify the object using AutoCAD commands and REM commands.

The following examples show some of the smart and connected options in use. In these examples, thin dotted lines show the region that is selected, and the thick black areas show the resulting enhanced bitonal region object.
The complete set of enhanced bitonal region objects is illustrated and defined in the Glossary. See entries under “connected” and “smart”.

**Enhanced bitonal region objects**

**Smart Window**

A Smart Window selects the raster entities that are entirely within the window. Entities that extend outside the window are not included in the selection. In this example, the leader lines and text are selected. The dimension lines extend outside the window and are not included.

**Connected Window**

A Connected Window selects the raster entities that are entirely within the window and not connected to entities extending outside the window. In this example, the text is selected. The leader lines are not selected because they are connected to the dimension lines that extend outside the window.

**Smart Crossing Window**

A Smart Crossing window selects the raster entities that are within the window, touch the window, or are connected to entities that touch the window. In this example, the leader lines, the text, and the dimension lines are selected.

**Connected Crossing Window**

A Connected Crossing window selects the raster entities that are within the window, touch the window, or are connected to entities that touch the window. In this example, all entities except the text in the upper right are selected. This text is not connected to any entities.

**Smart Fence**

**Connected Fence**
Enhanced bitonal region objects

A Smart Fence selects the raster entities that touch the fence. In this example, the leader lines and the dimension lines are included in the selection. The text, which is enclosed by the fence but does not touch the fence, is not included.

A Connected Fence selects the raster entities that touch the fence or are connected to entities that touch the fence. In this example, all entities except the two areas of text are selected. The text does not touch the fence and is not connected to any entities.

Using AutoCAD Commands on REM Objects

After you create custom REM objects, you can edit them with any of the following AutoCAD commands:

- MOVE
- STRETCH
- ROTATE
- SCALE
- COPY
- MIRROR
- ERASE
- UNDO
- MODIFY

**NOTE** AutoCAD commands that cannot be used on REM objects are TRIM, EXTEND, and EXPLODE.
When you run an AutoCAD command that causes a REM object to become out of sync with the original image, Raster Design erases the corresponding raster data from the source image. For example, after you use the AutoCAD MOVE command on a REM object, the original raster entities are deleted from the image. If you want to immediately delete a REM object after defining it, use the AutoCAD ERASE command. See AutoCAD Help for more information about AutoCAD commands.
Task-Specific Concepts

This chapter introduces you to some common image management tasks. Each section includes a short LiveView exercise with a sample drawing. You can use these explanations and exercises to begin working with AutoCAD Raster Design.

The drawings and images used in the LiveView exercises are located in the folder Program Files\Autodesk\AutoCAD Raster Design 2012\Getting Started Guide.

Despeckling an Image

You can despeckle an image to remove small spots that were created in the scanning process. To start the process, specify the largest size of speckle to delete. Raster Design then deletes all speckles of that size or smaller. Before you despeckle an image, you should examine it to identify any small points that must not be deleted. Then you can specify a speckle size that is smaller than the marked points to be retained in the drawing.

LiveView Exercise: Image Despeckling

In this exercise, you clean up a drawing by removing speckles.

To remove speckles from an image
1 Open the file C:\Program Files\Autodesk\AutoCAD Raster Design 2012\Getting Started\LiveView_Clean.dwg
This drawing includes a red vector triangle around one of the largest speckles in the image.

2 Zoom your display in to clearly see the speckle inside the red triangle.

3 Click Raster menu ➤ Cleanup ➤ Despeckle.
Press Enter to process the entire image.

4 Click the speckle inside the red triangle.
The system reports the size of the speckle (0.025 drawing units or 5 pixels), and highlights all speckles smaller than this size as candidates for removal.
5 Pan and zoom around the image to review the speckles. Click to deselect any speckles that you do not want removed, such as the period in A.C. SLEEVE in the upper left. Press Enter to remove the highlighted speckles.

6 In the upper left, note several speckles that were not removed because they are larger than the one you picked inside the red triangle. You can manually delete these.
Rubbing and Cropping Images

You can use the rub (Remove) and Crop commands to remove selected areas of bitonal, grayscale, and color images. Rubs and crops permanently alter an image.

- Rub changes the removed pixels to the current transparent color for the image. The rubbed areas become transparent if background transparency is enabled for the image. To rub image data, use the Raster menu ➤ Remove sub-menu, or one of the following commands: iremove, irubarc, irubcirc, irubcircle, irubdiag, irubline, irubpoly, or irubrect.

- Crop deletes pixel data outside the selected boundary area. If a crop boundary is not rectangular, the area between the crop boundary and the rectangular image frame is filled with the transparent color. To crop image data, use the Raster menu ➤ Crop sub-menu, or one of the following commands: icropcirc, icropdiag, icropline, icroppoly, or icroprect.

Rub and crop boundaries can be composed from many different shapes: circles, rectangles, lines, arcs, and polygons. The boundaries can encompass more than one image at a time. In the cropped floorplan illustration, note that the size of the image frame is automatically adjusted when you crop an image.

Some key points about rubs and crops are as follows:

- When two images are on top of each other and you rub or crop the visible image, both images are modified. Lock the layer an image frame is on to prevent the image from being modified.
Rubs and crops do not affect vectors in the rub or crop area. The commands affect only raster data.

Rubs create either transparent or solid regions, depending on the state of background transparency in the image.

A crop affects only the images you touch with the crop boundary. No images outside this boundary are affected.

You can use the autorub command to set the rub/crop line width, as well as to turn autorub on or off.
LiveView Exercise: Rubbing and Cropping an Image

In this exercise, you rub some small entities from an image and crop around another entity.

To rub and crop objects

1. Open the file `C:\Program Files\Autodesk\AutoCAD Raster Design 2012\Getting Started Guide\LiveView_Rub.dwg`
   You see a number of separate entities in a scanned image.

2. Zoom your display in to clearly see the Mandrel Rib Plate object.
   In the next few steps, you will remove this object from the image.

3. Click Raster menu ➤ Remove ➤ Rectangular Region.
   Click and draw a rectangle around the Mandrel Rib Plate and its title block, right-click, then click Enter to rub the region.
   Further exploration: Rub other objects, except the Jig Bracket in the lower left corner. Use some of the other region types on the Remove menu to do this.
4 Zoom your display in to clearly see the Jig Bracket in the lower left corner. In the next step you will create a crop region around this object.

5 Click Raster menu ➤ Crop ➤ Rectangular Region. Click and draw a rectangle around the Jig Bracket and its title block, then click. All of the image lying outside the crop region is deleted. If desired, you can save this Jig Bracket image with a new name.
Editing Raster Using REM

You can use raster entity manipulation (REM) to edit bitonal raster data with precise control. For example, you can adjust the radius of a raster circle, remove some dimension lines from a mechanical drawing, or copy electrical symbols from one image to another.

By creating REM objects from selected raster lines and other entities, you can edit raster entities as you would vector objects. For example, AutoCAD commands, such as MOVE, SCALE, COPY, and ROTATE, can operate on REM objects.

Some common uses of REM are as follows:

■ Make simple changes in raster entities
■ Erase a portion of a drawing
■ Move or clip some details
■ Store raster-only drawings (rather than hybrid drawings)

LiveView Exercise: Editing with REM

In this exercise you use REM commands to clean up a drawing.

To edit a drawing by using a REM object

1. Open the file C:\Program Files\Autodesk\AutoCAD Raster Design 2012\Getting Started\Guide\LiveView_REM.dwg
2. Zoom in to the upper left corner of the building. You will use window 1 on the upper left as a template to replace window 2.
2 Click Raster menu ➤ Raster Entity Manipulation ➤ Create Enhanced Bitonal Region ➤ Connected Fence. Draw the fence across the bottom half of window 2, right-click, and click Enter. The complete outline of the window is converted to a REM region because all the lines are connected to the two lines that crossed the fence.

3 Select the border of the REM region, right-click and click Cut. The window outline is deleted, leaving a red X to mark its bottom left corner.

4 Use another connected fence to create an enhanced bitonal region for window 1. Select the REM region, right-click and click Copy With Base Point.

5 Click the bottom left corner of window 1 to specify the base point, right-click, and click Paste. Align the cursor with the red X for window 2, and click to paste the REM window in the right location.

6 Click the REM window, then click Raster menu ➤ Raster Entity Manipulation ➤ Merge To Raster Image. REM window 1 is converted to raster. Further exploration: Copy the REM window and replace the two windows below windows 1 and 2.
Editing Color Maps

The color map for an image defines how the image data appears in the display. Color maps are especially important for digital elevation models (DEM) and multispectral images. These file types offer you a range of data to display, depending on your needs.

DEM Display

Using Raster Design, you can display a DEM land surface, color coded by elevation, degree of slope, or aspect (direction of slope). In the Palette Color Map Definition dialog box, specify which of these attributes to display, then set the number of value ranges, the color for each range, and the strategy for distributing the ranges across the full extent of data values.

When determining value distribution, you can select equal, quantile, or standard deviation. For a traditional map style, select an equal distribution of ranges. If your data points are clustered around a particular value and you want to show greater detail in that subset of ranges, choose a quantile...
distribution, which places an equal number of data points in each range. The third choice is a standard deviation distribution, which divides the ranges symmetrically above and below the arithmetic mean data value. This distribution is especially useful for showing the average range or dominant trends in the surface slope and elevation.

Multispectral Data Display

Satellite imagery and other multispectral data includes a separate image for each data band within the file set. For example, the set can include images for red, green, blue, and infrared data bands. Using a band assignment color map in Raster Design, you can combine different bands to highlight particular features of the image data.

You can use the Image Insertion dialog box to assign a data band to each color channel and decide which channels to include in the display. At any time, you can change the band assignment and view the results on the screen.
LiveView Exercise: Editing a Palette Color Map

In this exercise you see how different palette color maps assist the visual analysis of a DEM.

To edit a palette color map

1. Open the file C:\Program Files\Autodesk\AutoCAD Raster Design 2012\Getting Started Guide\LiveView_ColorMap.dwg

   A terrain map is displayed that shows several different colors. In the next few steps you will see the color map that shows how to interpret these colors.

2. If the Image Manager toolspace is not open, click Raster menu ➤ Manage. In Image Manager, select the Image Insertions view.

3. In the Image Insertions view, right-click the image name and click Edit Color Map.

4. In the Palette Assignment Color Map dialog box, click to edit the color map.
5 In the Palette Color Map Definition dialog box, in the Range Table, note that each color on the map represents an elevation range of 86.57 m. Click OK to close the dialog box.

6 In the Palette Assignment Color Map dialog box, select the Slope color map, then click Apply. The colors on the map now show ranges of ground slope values.

7 Click to see the Range Table for this color map. Note that each color represents a slope range of 7 degrees. Further exploration: In the Palette Color Map Definition dialog box for a color map, change the Value Distribution from Equal to Quantile, click OK, then click Apply.
LiveView Exercise: Editing a Band Assignment Color Map

In this exercise you see how different band assignment color maps assist the visual analysis of a multispectral data set.

To edit a band assignment color map:

1. Open the file `C:\Program Files\Autodesk\AutoCAD Raster Design 2012\Getting Started Guide\LiveView_ColorMap2.dwg`.
   A satellite image is displayed that shows some urban terrain in normal colors.

2. If the Image Manager toolspace is not open, click Raster menu ➤ Manage. In Image Manager, select the Image Insertions view.

3. In the Image Insertions view, right-click the image name and click Edit Color Map.

4. In the Band Assignment Color Map dialog box, note that the red, green, and blue channels on the left are assigned to the corresponding red, green, and blue data bands.
In the Band Assignment Color Map dialog box, use the three drop-down lists to assign the color channels as follows:

- Red channel to the Near Infrared (NIR) band
- Green channel to the Red band
- Blue channel to the Green band

Click Apply to see the change immediately, and click OK to close the dialog box.

This color map shows vegetation as red. Vegetation that is healthy or more dense appears darker red. This type of display is known as a false color image, and this particular band assignment is commonly used for analyzing vegetation.
Editing Indexed Color Images

Using the Palette Manager, you can control the 256 colors or shades of gray in any indexed image. For example, you can combine similar shades to reduce the palette, or highlight some details in the image by blanking out the rest.

As shown in Managing the Image Palette on page 41, the array of 256 squares at the top of the Palette Manager is known as the color table. The display at the bottom is an interactive list view. Using the Sort By drop-down list in the upper right, you can sort a palette by index number, frequency, background transparency, color, hue, saturation, or luminance.

LiveView Exercise: Highlighting Image Details

In this exercise you use the Palette Manager to prepare a contour map from a map image that contains many other details.

To extract contours from a detailed map:

1. Open the file C:\Program Files\Autodesk\AutoCAD Raster Design 2012\Getting Started Guide\Live_View_Palette.dwg
   A map of Pinedale is displayed, showing roads, rivers, buildings, and other details.

2. Zoom in to the map so you can clearly pick the color of the contour lines.
3 Click Raster menu ➤ Image Processing ➤ Palette Manager. The Palette Manager dialog box displays the color palette for the map.

4 Click Select Color, then click one of the contour lines in the drawing. The brown color (index 8) is highlighted in the Palette Manager, showing numeric values.

5 Right-click the selected color square on the top row of the Palette Manager. Click Invert Selection. All colors except brown are selected. To isolate the contour lines, you can turn all the selected colors to white.

6 Click Combine. In the Target Color dialog box, click the white square, then click OK. Note the change in the Frequency column of the table: all colors except indices 0 and 8 now have a frequency of 0.

7 Click OK. The change is applied to the drawing. The resulting image could be used to prepare a contour map of the region.
Merging Vectors into Raster

You can use the vector merge command to merge vectors into either an existing or new raster image. Vector merge allows you to make precise changes to your raster image using AutoCAD vectors, while keeping your data in a raster format.

When you merge vectors, you can select raster pen widths for the merge by specifying pen thickness in the Raster Pen Settings dialog box.

![Raster Pen Settings dialog box]

Raster pens apply a specified line width to vector entities when you merge them into the image. Line widths are assigned according to entity color.

LiveView Exercise: Merging Vectors

In this exercise, you update a drawing and merge new vector data with existing raster data.

To merge vectors into raster data

1. Open the file C:\Program Files\Autodesk\AutoCAD Raster Design 2012\Getting Started Guide\LiveView_Merge.dwg

You see a drawing of a school. The white raster data indicates the original building, and the colored vector data indicates the additional classrooms.
2 Click Raster menu ➤ Merge ➤ Configure Raster Pens to open the Raster Pen Settings dialog box.

3 Select the Red pen color, set its pen width to 1 pixel, then click OK. With this setting, the doors will be drawn in thinner raster lines than the walls.

4 Click Raster menu ➤ Merge ➤ Vector Into Raster. Select the vector block of new classrooms by drawing a window around it, then right-click to end the selection. Press Enter to accept the default setting of deleting the vectors after the merge. The vector data is merged with the raster data.
Using Histogram Editing Filters

The Histogram dialog box provides a set of multi-purpose editing filters you can use to permanently change the appearance of grayscale and color images. A histogram is a bar graph that represents the number of pixels per pixel shade in a selected image or images. Dark pixels are shown on the left, grays or mid-tones are in the middle, and lighter shades are on the right. The number of pixels per pixel shade is represented by the height of the corresponding bar.

When you use the Histogram (ihistogram) command on an image, the Histogram dialog box displays a histogram and a preview of the image.

Some of the ways you can use the Histogram dialog box to modify an image are as follows:

- Adjust the brightness and contrast of one or more images using the Brightness/Contrast tab.
- Maximize the image detail using the Equalize tab.
- Convert grayscale and color images to bitonal images using the Threshold tab.
- Convert color images to grayscale using the Color To Grayscale tab.
- Adjust the contrast in a non-linear fashion using the Tonal Adjustment tab.

The Image Adjust color map (or AutoCAD IMAGEADJUST command) makes display-only adjustments, but the edits you make to an image using the Histogram command are permanent and saved with the image.

You can limit the effect of brightness, contrast, equalizing, or tonal adjustments to a portion of the image called a subregion. You can define a subregion using one of four methods:

- Use an existing closed vector entity to define the region.
- Use an existing image clip.
- Define a rectangular subregion by clicking two points.
- Define a polygonal subregion by clicking several points.

Other points to note:

- The histogram adjustments affect all images that are currently selected, not only the image displayed in the preview. You can preview how the histogram adjustments will affect an image in the selection set by clicking its name in the list of images.
- For color images, you can modify all channels (Red, Green, and Blue) together or separately.
- If you make changes to the display of the image using the Image Adjust color map or AutoCAD IMAGEADJUST command, then the image saved to disk is displayed in the Histogram Preview area. If you make changes to the image with the ihistogram command, then the Image Adjust controls are reset.
LiveView Exercise: Using Histogram Filters

In this exercise, you explore the effects of different histogram filters on a grayscale image.

To make tonal adjustments to an image

1. Open the file C:\Program Files\Autodesk\AutoCAD Raster Design 2012\Getting Started Guide\LiveView_Histogram.dwg. You see three numbered copies of a grayscale aerial photo in which some areas are too light and others too dark.

2. Select image 1 and zoom in on it. Click Raster menu ➤ Image Processing ➤ Histogram. Press Enter to process the entire image.

3. In the Histogram dialog box, click the Brightness/Contrast tab. Adjust the Brightness and Contrast sliders, noting the effects in the Preview. Choose a setting that improves the image visibility. Click Apply, then click Close.

4. Select image 2, and repeat Step 2 to open the Histogram dialog box. This time, click the Equalize tab. Click Apply to equalize the image, then click Close.
5 Select image 3, and repeat Step 2 to open the Histogram dialog box. This time, click the Tonal Adjustment tab. In the graph window for the fitted curve, click on the diagonal line above and below the midpoint to add two more control points. Adjust the position of the control points to lighten the dark areas and darken the light areas. Click Apply, then click Close.

6 If you want to try using different histogram controls to edit the image, insert additional copies of the image. To do this, ensure that Image Manager is open (if necessary, click Raster menu ➤ Manage). In the Image Data view, right-click the image name and click New Insertion.
Using Vector Follower Tools

Vectorization tools (VTools) partially automate the process of vectorizing raster entities. Each tool is designed to follow and vectorize a particular raster geometry type.

Vectorization tools include three followers:

- Polyline Follower. Converts raster polylines to AutoCAD polylines.
- Contour Follower. Converts raster contours to AutoCAD contour objects or to polylines with elevation. When a contour is completed, the contour follower prompts you to enter elevation data.
- 3D Polyline Follower. Traces a defined fence or existing vector polyline, stopping at each point where it intersects a raster entity (raster impact point) to prompt for elevation data. The resulting AutoCAD 3D polyline represents the elevation of the raster contours it intersects.

You can use the contour follower to vectorize a contour and the vtext command to convert the text label associated with it.
LiveView Exercise: Vectorizing Contours

In this exercise you use the contour follower to vectorize raster contours and record their elevation.

To convert a raster contour to a vector polyline

1. Open the file C:\Program Files\Autodesk\AutoCAD Raster Design 2012\Getting Started Guide\LiveView_Contour.dwg
   You see a small contour map of rugged terrain.

2. Click Raster menu ➤ Options to open the Raster Design Options dialog box. Click the VTools General tab. In the Removal Method area, click Rub. Click the VTools Follower tab. In the Contour Settings area, select Contour Creates Polyline and set Elevation Interval to 20. Click OK.
   These settings ensure that when you trace a raster contour, it is replaced by a vector polyline and the original raster is erased.

3. Zoom your display in to see the 7200 contour.
   Click Raster menu ➤ Vectorization Tools ➤ Contour Follower, then click anywhere along the 7200 contour. A polyline is created from the edge of the drawing to the decision point at the label. Now the application needs direction from you on whether to end or continue.
4 Click one or two points across the label gap. Enter 0 to continue the line to the end. Right-click and click Enter. Enter 7200 for the elevation.

5 Click the contour line to the left of 7200, then right-click and click Enter. Because it has no label gap, this line is vectorized completely with one click. On the command line, you are prompted with 7220, the correct elevation for this line. This occurs because you set Raster Design options to match the elevation interval in the drawing. Press Enter to accept the elevation, then press Esc to end the command.

Using Vector Follower Tools

Vectorization tools (VTools) partially automate the process of vectorizing raster entities:

- Polyline Follower. Converts raster polylines to AutoCAD polylines.
Supported Image Formats

AutoCAD Raster Design 2012 can use many common bitonal, grayscale, and color image formats, including multispectral GeoTIFF data and digital elevation models (DEM). Raster Design also supports all the image formats that AutoCAD 2012 supports.

Understanding Image Formats

If you open a drawing containing an image format that is not supported, Raster Design does not load the image. If you attempt to insert an image that uses an unsupported format, you are warned that the format is not supported.

Similarly, if you select several files and select the Treat As Multispectral option, Raster Design checks whether the files share the same coordinate system, projection, color depth, extents, and units. If these criteria are not met, the files cannot be used as a multispectral dataset. However, they may be displayable individually, and you may be able to edit them to resolve the differences.

If you insert a read-only image into your drawing, you can configure a color map for it and save it in a drawing. You can use the Raster menu ➤ Capture command to save a displayable image for use in other applications. If you want to edit the image, you can use the Raster menu ➤ Save As command to save the image to a read-write format before or after you edit it.

Raster Design can read and write world files for any image type. World files contain correlation information for images, such as scale, rotation, and insertion point.
Raster Design can write or save images in 1-, 8-, 16-, 24-, or 32-bit format, but it can read more image formats than it can write. The following table provides details about how the various formats are supported:

<table>
<thead>
<tr>
<th>Supported Image Formats</th>
<th>Format</th>
<th>File extension</th>
<th>Description</th>
<th>Read (bits per pixel)</th>
<th>Write (bits per pixel)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>BMP</strong></td>
<td>BMP, RLE, DIB</td>
<td>Windows Bitmap</td>
<td>1, 8, 24, 32</td>
<td>1, 8, 32</td>
<td></td>
</tr>
<tr>
<td><strong>CALS</strong></td>
<td>CAL, GP4, RST, MIL, CG4</td>
<td>Computer-Aided Acquisition and Logistics Support</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td><strong>DEM</strong></td>
<td>DEM</td>
<td>Digital Elevation Model</td>
<td>32</td>
<td>32</td>
<td></td>
</tr>
<tr>
<td><strong>DOQ</strong></td>
<td>DOQ, NWS, NES, SES, SWS</td>
<td>Digital Orthophoto Quadrangle</td>
<td>8, 24</td>
<td>read only</td>
<td></td>
</tr>
<tr>
<td><strong>DTED</strong></td>
<td>DT0, DT1, DT2</td>
<td>Digital Terrain Elevation Data</td>
<td>16, 32</td>
<td>read only</td>
<td></td>
</tr>
<tr>
<td><strong>ECW</strong></td>
<td>ECW</td>
<td>Enhanced Compressed Wavelet</td>
<td>8, 24, 32</td>
<td>read only</td>
<td></td>
</tr>
<tr>
<td><strong>ESRI ASCII Grid</strong></td>
<td>ASC</td>
<td>ESRI interchange format</td>
<td>16</td>
<td>read only</td>
<td></td>
</tr>
<tr>
<td><strong>ESRI Binary Grid</strong></td>
<td>ADF</td>
<td>ESRI internal format</td>
<td>16</td>
<td>read only</td>
<td></td>
</tr>
<tr>
<td><strong>FLIC</strong></td>
<td>FLC, FLI</td>
<td>Animator FLIC</td>
<td>8</td>
<td>read only</td>
<td></td>
</tr>
<tr>
<td><strong>GeoSPOT</strong></td>
<td>BIL</td>
<td>SPOT Image Corporation’s raster format with georeferencing format</td>
<td>8, 24</td>
<td>read only</td>
<td></td>
</tr>
<tr>
<td>Format</td>
<td>File extension</td>
<td>Description</td>
<td>Read (bits per pixel)</td>
<td>Write (bits per pixel)</td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>----------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-----------------------</td>
<td>------------------------</td>
<td></td>
</tr>
<tr>
<td>GeoTIFF</td>
<td>TIF, TIFF</td>
<td>Geo-referenced TIFF</td>
<td>1, 4, 8, 16, 24, 32</td>
<td>1, 8, 16, 32</td>
<td></td>
</tr>
<tr>
<td>GIF</td>
<td>GIF</td>
<td>Compuserve® Graphics Interchange Format</td>
<td>8</td>
<td>read only</td>
<td></td>
</tr>
<tr>
<td>IG4</td>
<td>IG4</td>
<td>Image Systems Group 4</td>
<td>1</td>
<td>read only</td>
<td></td>
</tr>
<tr>
<td>JFIF- JPEG</td>
<td>JPG</td>
<td>Joint Photographics Expert Group, best suited for 24-bit images</td>
<td>8, 24, 32</td>
<td>8, 24</td>
<td></td>
</tr>
<tr>
<td>JPG2000</td>
<td>JP2, J2K</td>
<td>JPEG 2000</td>
<td>8, 24</td>
<td>8, 24</td>
<td></td>
</tr>
<tr>
<td>Landsat</td>
<td>FST</td>
<td>Multispectral format used by Landsat 7, primarily for multiframe image sets.</td>
<td>8</td>
<td>read only</td>
<td></td>
</tr>
<tr>
<td>FAST-L7A</td>
<td>FST</td>
<td>Multiresolution Seamless Image Database</td>
<td>8, 24, 32</td>
<td>read only</td>
<td></td>
</tr>
<tr>
<td>MrSID</td>
<td>SID</td>
<td>Multiresolution Seamless Image Database</td>
<td>8, 24, 32</td>
<td>read only</td>
<td></td>
</tr>
<tr>
<td>NITF</td>
<td>NTF</td>
<td>National Imaging Transmission Format; can be multiframe multispectral</td>
<td>1, 8, 24, 32</td>
<td>read only</td>
<td></td>
</tr>
<tr>
<td>PCX</td>
<td>PCX</td>
<td>A simple run-length encoded format</td>
<td>1, 4, 8, 24</td>
<td>1, 8</td>
<td></td>
</tr>
</tbody>
</table>
## Supported Image Formats

<table>
<thead>
<tr>
<th>Format</th>
<th>File extension</th>
<th>Description</th>
<th>Read (bits per pixel)</th>
<th>Write (bits per pixel)</th>
</tr>
</thead>
<tbody>
<tr>
<td>PICT</td>
<td>PCT, PICT</td>
<td>Apple® Computer format</td>
<td>8, 24, 32</td>
<td>read only</td>
</tr>
<tr>
<td>PNG</td>
<td>PNG</td>
<td>Portable Network Graphics</td>
<td>1, 4, 8, 24, 32</td>
<td>1, 8, 24, 32</td>
</tr>
<tr>
<td>QuickBird TIFF</td>
<td>TIF, TIFF</td>
<td>Images from DigitalGlobe's QuickBird satellite; typically multiframe, multispectral, but can also be single-frame panchromatic</td>
<td>8, 16</td>
<td>read only</td>
</tr>
<tr>
<td>RLC1</td>
<td>RLC</td>
<td>Run-Length Coding with no header</td>
<td>1</td>
<td>read only</td>
</tr>
<tr>
<td>RLC2</td>
<td>RLC</td>
<td>RLC with IST headers</td>
<td>1</td>
<td>read only</td>
</tr>
<tr>
<td>TARGA</td>
<td>TGA</td>
<td>Format developed by Truevision Inc. Usually 24-bit true color; can be 8-bit grayscale or simple run length encoded</td>
<td>8, 16, 24, 32</td>
<td>8, 32</td>
</tr>
<tr>
<td>TIFF</td>
<td>TIF, TIFF</td>
<td>Tagged Image File Format, developed by Aldus Corporation</td>
<td>1, 4, 8, 16, 24, 32</td>
<td>1, 8, 16, 32</td>
</tr>
</tbody>
</table>
You can access Raster Design commands on the Raster menu or by entering a command on the command line.

The table in this appendix lists the menu options and their corresponding command line names according to their groupings on the Raster menu.

## Command Summary

The following table shows each Raster menu option and its corresponding command.

<table>
<thead>
<tr>
<th>Raster menu</th>
<th>Command line access</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>inew</td>
</tr>
<tr>
<td>Insert</td>
<td>insert</td>
</tr>
<tr>
<td>Save</td>
<td>isave</td>
</tr>
<tr>
<td>Save As</td>
<td>isaveas</td>
</tr>
<tr>
<td>Export submenu</td>
<td></td>
</tr>
<tr>
<td>Image</td>
<td>iexport</td>
</tr>
<tr>
<td>World File</td>
<td>iworldout</td>
</tr>
<tr>
<td>Image Embed</td>
<td>iembed</td>
</tr>
<tr>
<td>Raster menu</td>
<td>Command line access</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Manage</td>
<td>imanage</td>
</tr>
<tr>
<td>Capture</td>
<td>icapture</td>
</tr>
<tr>
<td>Correlate submenu</td>
<td></td>
</tr>
<tr>
<td>Match</td>
<td>imatch</td>
</tr>
<tr>
<td>Displace</td>
<td>idisplace</td>
</tr>
<tr>
<td>Scale</td>
<td>iscale</td>
</tr>
<tr>
<td>Rubbersheet</td>
<td>irsheet</td>
</tr>
<tr>
<td>Cleanup submenu</td>
<td></td>
</tr>
<tr>
<td>Deskew</td>
<td>ideskew</td>
</tr>
<tr>
<td>Despeckle</td>
<td>idespeckle</td>
</tr>
<tr>
<td>Bias</td>
<td>ibias</td>
</tr>
<tr>
<td>Invert</td>
<td>iinvert</td>
</tr>
<tr>
<td>Mirror</td>
<td>imirror</td>
</tr>
<tr>
<td>Touchup</td>
<td>itouchup</td>
</tr>
<tr>
<td>Image Processing submenu</td>
<td></td>
</tr>
<tr>
<td>Histogram</td>
<td>ihistogram</td>
</tr>
<tr>
<td>Convolve</td>
<td>iconvolve</td>
</tr>
<tr>
<td>Bitonal Filters</td>
<td>ibfilter</td>
</tr>
<tr>
<td>Change Density</td>
<td>idensity</td>
</tr>
<tr>
<td>Change Color Depth</td>
<td>idepth</td>
</tr>
</tbody>
</table>
### Raster menu

| Palette Manager | ipal |

### Raster Entity Manipulation (REM) submenus

#### REM ➤ Create Region

<table>
<thead>
<tr>
<th>Polygonal</th>
<th>ispolyreg</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rectangular</td>
<td>isrectreg</td>
</tr>
<tr>
<td>Diagonal</td>
<td>isdiagreb</td>
</tr>
<tr>
<td>Circular</td>
<td>iscircreg</td>
</tr>
<tr>
<td>From Existing</td>
<td>iregfromvec</td>
</tr>
<tr>
<td>Vector</td>
<td></td>
</tr>
</tbody>
</table>

#### REM ➤ Create Enhanced Bitonal Region

<table>
<thead>
<tr>
<th>Smart Window</th>
<th>isebrsmart /w</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smart Crossing</td>
<td>isebrsmart /c</td>
</tr>
<tr>
<td>Smart Window Polygon</td>
<td>isebrsmart /wp</td>
</tr>
<tr>
<td>Smart Crossing Polygon</td>
<td>isebrsmart /cp</td>
</tr>
<tr>
<td>Smart Fence</td>
<td>isebrsmart /f</td>
</tr>
<tr>
<td>Connected Entity</td>
<td>isebrcon /e</td>
</tr>
<tr>
<td>Connected Window</td>
<td>isebrcon /w</td>
</tr>
<tr>
<td>Connected Crossing</td>
<td>isebrcon /c</td>
</tr>
<tr>
<td>Connected Window Polygon</td>
<td>isebrcon /wp</td>
</tr>
<tr>
<td>Raster menu</td>
<td>Command line access</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Connected</td>
<td>isebrcon /cp</td>
</tr>
<tr>
<td>Crossing Polygon</td>
<td></td>
</tr>
<tr>
<td>Connected Fence</td>
<td>isebrcon /f</td>
</tr>
<tr>
<td>REM ➤ Create Primitive</td>
<td></td>
</tr>
<tr>
<td>Smart Pick</td>
<td>isset</td>
</tr>
<tr>
<td>Line</td>
<td>isline</td>
</tr>
<tr>
<td>Circle</td>
<td>iscircle</td>
</tr>
<tr>
<td>Arc</td>
<td>isarc</td>
</tr>
<tr>
<td>From Existing Vector</td>
<td>iprimfromvec</td>
</tr>
<tr>
<td>Raster Entity Manipulation</td>
<td></td>
</tr>
<tr>
<td>Clear Selected</td>
<td>iclear</td>
</tr>
<tr>
<td>Clear All</td>
<td>iclearall</td>
</tr>
<tr>
<td>Select All</td>
<td>iselectall</td>
</tr>
<tr>
<td>Refine Mode</td>
<td>irefinemode</td>
</tr>
<tr>
<td>Remove Data From Region</td>
<td>iremove</td>
</tr>
<tr>
<td>Merge To Raster Image</td>
<td>imergetoimg</td>
</tr>
<tr>
<td>Convert To Raster Image</td>
<td>iconvtoimg</td>
</tr>
<tr>
<td>Background Transparency</td>
<td>itransparent</td>
</tr>
<tr>
<td>REM ➤ REM Operations</td>
<td></td>
</tr>
<tr>
<td>Raster menu</td>
<td>Command line access</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Smooth</td>
<td>ismooth</td>
</tr>
<tr>
<td>Trim</td>
<td>itrtrim</td>
</tr>
<tr>
<td>Extend</td>
<td>iextend</td>
</tr>
<tr>
<td>Fillet</td>
<td>ifillet</td>
</tr>
<tr>
<td>Offset</td>
<td>ioffset</td>
</tr>
</tbody>
</table>

**Raster Entity Manipulation**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy To Clipboard</td>
<td>icopyss</td>
</tr>
<tr>
<td>Knife</td>
<td>iknife</td>
</tr>
</tbody>
</table>

**Mask submenu**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Create</td>
<td>imask</td>
</tr>
<tr>
<td>Convert To Image Clip</td>
<td>imaskconvert</td>
</tr>
<tr>
<td>Redefine</td>
<td>imaskedit</td>
</tr>
</tbody>
</table>

**Crop submenu**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>icropline</td>
</tr>
<tr>
<td>Circular Region</td>
<td>icropcirc</td>
</tr>
<tr>
<td>Rectangular Region</td>
<td>icroprect</td>
</tr>
<tr>
<td>Diagonal Region</td>
<td>icropdiag</td>
</tr>
<tr>
<td>Polygonal Region</td>
<td>icroppoly</td>
</tr>
<tr>
<td>Aligned Rectangular Region</td>
<td>icropalign</td>
</tr>
<tr>
<td>Raster menu</td>
<td>Command line access</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Remove submenu</td>
<td></td>
</tr>
<tr>
<td>Line</td>
<td>irubline</td>
</tr>
<tr>
<td>Circle</td>
<td>irubdonut</td>
</tr>
<tr>
<td>Arc</td>
<td>irubarc</td>
</tr>
<tr>
<td>Polyline</td>
<td>irubpline</td>
</tr>
<tr>
<td>Circular Region</td>
<td>irubcirc</td>
</tr>
<tr>
<td>Rectangular Region</td>
<td>irubrect</td>
</tr>
<tr>
<td>Diagonal Region</td>
<td>irubdiag</td>
</tr>
<tr>
<td>Polygonal Region</td>
<td>irubpoly</td>
</tr>
<tr>
<td>Raster Under Vector</td>
<td>irmvexisting</td>
</tr>
<tr>
<td>Smart Pick</td>
<td>idelsmart</td>
</tr>
<tr>
<td>Line Entity</td>
<td>idelline</td>
</tr>
<tr>
<td>Circle Entity</td>
<td>idelcircle</td>
</tr>
<tr>
<td>Arc Entity</td>
<td>idelarc</td>
</tr>
<tr>
<td>Merge submenu</td>
<td></td>
</tr>
<tr>
<td>Images</td>
<td>iimerge</td>
</tr>
<tr>
<td>Vector Into Raster</td>
<td>ivmerge</td>
</tr>
<tr>
<td>Configure Raster Pens</td>
<td>rpens</td>
</tr>
</tbody>
</table>

Vectorization Tools (VTools) submenu
<table>
<thead>
<tr>
<th>Raster menu</th>
<th>Command line access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>vline</td>
</tr>
<tr>
<td>Polyline</td>
<td>vpoly</td>
</tr>
<tr>
<td>Rectangle</td>
<td>vrect</td>
</tr>
<tr>
<td>Circle</td>
<td>vcircle</td>
</tr>
<tr>
<td>Arc</td>
<td>varc</td>
</tr>
<tr>
<td>Text</td>
<td>vtext</td>
</tr>
<tr>
<td>Multiline Text</td>
<td>vmtext</td>
</tr>
<tr>
<td>Polyline Follower</td>
<td>vfpoly</td>
</tr>
<tr>
<td>Contour Follower</td>
<td>vfcontour</td>
</tr>
<tr>
<td>3D Polyline Follower</td>
<td>vf3dpoly</td>
</tr>
</tbody>
</table>

Text Recognition submenu

| Recognize Text                  | irectext            |
| Recognize Table                 | irectable           |
| Recognize Setup                 | irecsetup           |
| Raster Snap                     | isnap               |
| Toggle Frames                   | iframe              |
| Toggle Quick Bar                | iqbar               |
| Raster Data Query               | iquery              |
| Options                         | ioptions            |

Raster Design Home Page          | http://www.autodesk.com/rasterdesignuser
<table>
<thead>
<tr>
<th>Raster menu</th>
<th>Command line access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help</td>
<td>ihelp</td>
</tr>
<tr>
<td>About Raster Design</td>
<td>iabout</td>
</tr>
</tbody>
</table>
Glossary

3-point affine transform  A type of coordinate transformation that can be applied to images upon insertion. This option replicates the transform used on non-editable data types. This type of transform is a translate, rotate, independent x-y scale transform without sheer.

4-point rubber sheet transform  A type of coordinate transformation that can be applied to images upon insertion. This option provides an approximate transformation that is most accurate in the vicinity of the reference points, but contains some distortion in other regions of the image.

access key  The key that corresponds to an underlined letter on a menu, command, or dialog box.

active path  The location from which the current image file is actually being loaded. It can be a local path, a network path, or an Internet address.

Always Detach  An option in the Raster Design Options dialog box. If you erase the image frames, this option automatically detaches the images.

aperture  The square region, centered on the cursor crosshairs, where entity selection can occur when raster snap mode is active; also known as the snap window. You can also specify minimum and maximum pixel widths to snap to. See also snap window.

apparent intersection  The point where two entities would intersect if one, or both, were extended.

aspect ratio  The ratio of an image height to its width. See also bias.

attach  When you insert an image into a frame, the image is attached to the drawing. You can use the AutoCAD IMAGEATTACH command to attach an image, or you can use the Raster Design insert command to attach an image. Attaching and inserting refer to the same process.

AutoInsert  A Raster Design option for automatically inserting images in a drawing created with CAD Overlay ESP or GSX, which are earlier versions of Raster Design.
**AutoReplace** A Raster Design option that replaces the image path of a previously inserted image by matching the drawing name.

**AutoRub** A Raster Design option that removes raster objects as you trace them with the vectorization tools. This option uses the Rub/Crop line width to determine the width of the raster that is removed.

**base point** A point used for relative distance and angle when moving, copying, or rotating objects. Example: On the image, select the base point that you want to move to the destination point.

**bias** The ratio of image width to image height, also called aspect ratio. You can change the bias of an image by using the Raster Design ibias command.

**bicubic** A pixel resampling method that computes the value for a new pixel based on interpolation of the values in a 4x4 block of surrounding pixels. This method provides a good compromise between accuracy and speed for most images.

**bilinear** A pixel resampling method that computes the value for a new pixel based on linear interpolation of the values in a 2x2 block of surrounding pixels.

**binary image** See bitonal image.

**bitmap (BMP)** An image format. It can be compressed or uncompressed. Uncompressed BMP files contain raw data on a boundary of 4 bytes per raster. Compressed files are similar to the run length encoded PCX files, with minor variations. Only 4- and 8-bit files can be compressed.

**bitonal image** A two-color, 1-bit image, usually a line drawing such as a floorplan or parcel map. This image type is also called binary. The background color of a bitonal image can be transparent or solid. The foreground color can be any color.

**blank distance** The distance between dashes in a dashed line.

**blurring** In Raster Design, a method for evenly weighing all pixels in the kernel, including the target. This filter, while similar to Low Pass #2, gives slightly brighter results.

**blurring artifacts** A loss of image detail that can occur with image compression and resampling techniques. The symptoms include excessive smoothness where different colors meet, color bleeding, and a loss of color texture.

**boundary** See frame, image frame.
bounding outline The visible element (usually a dotted rectangle) that is displayed when you select a region. Also called bounding box.

brightness The luminance of pixels in an image. A higher brightness value makes all the pixels lighter.

CAD Overlay GSX and CAD Overlay ESP Previous releases of Raster Design.

CALS Acronym for the raster image format Computer Aided Acquisition Logistics and Support. CALS files are black and white images used by the US Government as part of the transition to electronic media. CALS images are Fax Group IV compressed and are therefore a good way to store black and white line drawings and scans.

channel A red, green, or blue color signal. Each Raster Design color image is composed of one or more color channels. In a single-band 8-bit image, the color palette translates the index triplet for each color into a value for each color channel, with a limit of 256 total colors for any pixel. In a true color, or 24-bit image, separate red, green, and blue data bands provide color values to each channel, and each pixel can represent a value from 0 through 255 in each of the three channels. The Band Assignment color map for multispectral images assigns image bands to color channels.

clipped image An image that has been cropped or reduced in area. The regions of the image that are outside the clip boundary are hidden from view. You can turn off the clip or you can delete the clip to redisplay all of the image. Unlike a crop, a clip is a display-only feature that you can use for viewing and plotting purposes. It does not permanently change image data.

color depth The amount of information stored with each pixel to define its color or shade. Common color depths are as follows:

<table>
<thead>
<tr>
<th>Color Depth</th>
<th>Type of Image</th>
<th>Available Color(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 bit</td>
<td>Bitonal</td>
<td>1 color</td>
</tr>
<tr>
<td>8 bit</td>
<td>Grayscale</td>
<td>256 shades of gray</td>
</tr>
<tr>
<td>4 bit</td>
<td>Color</td>
<td>16 colors</td>
</tr>
<tr>
<td>8 bit</td>
<td>Color</td>
<td>256 colors</td>
</tr>
<tr>
<td>16 bit</td>
<td>Grayscale</td>
<td>65,536 shades of gray</td>
</tr>
</tbody>
</table>
**color map** An assignment of colors to data values for the purpose of displaying the contents of a file in a meaningful way.

Users work with two main types of color maps. A palette color map is used with digital elevation models (DEM) to specify whether to display surface elevations or slopes, and how to distribute the set of colors across the range of data values.

A band assignment color map is used with multispectral data to select the data bands to display and to assign each band to a color channel (red, blue, or green). Raster Design automatically assigns a color map to image files that are inherently displayable, such as aerial photos and bitonal images.

**connected crossing polygon** A selection method for enhanced bitonal region objects. This method selects all raster entities that are within the polygon, crossing the polygon, or connected to entities that cross the polygon boundary. In the following example, note that the text in the upper right is not selected because it is the only entity not connected to entities that cross the polygon boundary.

**connected crossing window** A selection method for enhanced bitonal region objects. This method selects all raster entities that are within the window, crossing the window, or connected to entities that cross the window boundary. In the following example, note that the text in the upper right is not selected because it is the only entity not connected to entities that cross the window boundary.
**Connected crossing window**

**connected entity** 1. An entity that is connected to an entity that is selected or otherwise referenced.

2. A selection method for enhanced bitonal region objects. This method selects a specified entity and all other entities connected to it. In the following example, note that a single click on the arrow in the upper right selects the entire connected structure except the two text entities, which are not connected to any other entity.

**connected fence** A selection method for enhanced bitonal region objects. This method selects all raster entities that are connected to any entity that touches the selection line (fence) you draw. Entities enclosed by the fence but not touching it are not selected. In the following example, the two text blocks are not selected because they do not touch the fence and are not connected to any entities that touch the fence.
**connected window** A selection method for enhanced bitonal region objects. This method selects only those raster entities that are entirely within the window you define and are not connected to any entity that extends outside the window. In the following example, note that the arrows are not selected because they are connected to lines that extend outside the window.

**connected window polygon** A selection method for enhanced bitonal region objects. This method selects only those raster entities that are entirely within the polygon you define and are not connected to any entity that extends outside the polygon. In the following example, note that the arrows are not selected because they are connected to lines that extend outside the polygon.
**continuous tone** A shaded image, sometimes called halftone in traditional printing.

**convolve filter** A type of image processing filter that can be used with grayscale images for various operations, such as smoothing or sharpening the image details.

**copylast** An option that is available when vectorizing text. It displays the VText Edit dialog box, which contains the last text string you placed in the drawing. You can edit the text string if needed, and then click OK and pick an insertion point for the copy.

**correlate** The process of positioning an image within the AutoCAD coordinate system so that the image dimensions and coordinates match AutoCAD units and coordinates.

**crop** A selected area of a raster image. Pixel data outside the crop is deleted. The image frame size is adjusted automatically. A crop permanently alters an image.

**data organization** The method of organizing the image data when the image is saved. The data organization can be stripped, tiled, or monolithic.

**datum** A reference point, line, or surface.

**decrement** To decrease by one.

**DEM** Digital elevation model. A format for recording land elevations in a digital file. A regular grid of survey points is created over the surface, and the elevation of each point is recorded as a floating-point number.

**density** The number of dots per linear unit at which an image is scanned or created. The more dots per unit, the higher the density and clarity of detail. Also called resolution or pixel density. See also DPI.

**density units** The linear units on which the image density is based. Example: Inches are the density units of an image that was scanned at 300 dots per inch.

**density value** The number of dots per unit that make up the image density. Example: An image scanned at 300 dots per inch has a density value of 300.

**deskew** To rotate a raster image, usually for the purpose of aligning it orthogonally with the AutoCAD coordinate system.

**destination point** The location to which you move an image. To move an image, you must pick a source point and a destination point.
**detach** To completely remove an image from a drawing. To reverse a detach operation, you must insert the image from its source. Operations similar to detach but less permanent are erase, unload, and hide.

**displace** To move an image from a source point to a destination point.

**display** The visual output device and its technology, such as a CRT-based display, a flat-panel display, or the graphics portion of your monitor.

**display order** The order in which images are displayed in AutoCAD. This sequence determines which images are above or below other images, and affects image visibility.

**dither** The process of using a pattern of solid dots to simulate more colors than are actually available.

**donut** A circle with a specified linewidth.

**DOQ** Digital orthophoto quadrangle raster image format, used for aerial photos that are processed to remove distortion. A typical DOQ represents one quarter of a USGS topographic map at 1:24 000 scale.

**DPI** Dots per inch. A measure of image density. *See also* resolution, density, PPI.

**Draft** An option in the Raster Design Options dialog box that does not dither the pixels. This setting is recommended for bitonal images.

**drawing image** A raster file of a drawing, a photograph, a map, or a satellite image that you can edit, manipulate, and manage using Raster Design.

**drawing unit** The unit on which an AutoCAD drawing is based. Example: A common Imperial drawing unit is inches. A common Metric drawing unit is meters.

**DTED** Digital Terrain Elevation Data. A grid-based file of elevation points. This format was developed by the U.S. National Imagery and Mapping Agency (NIMA).

**ECW** Enhanced Compressed Wavelet. A highly-compressed image format from ER Mapper, Inc.

**edge enhancement filters** Filters that improve the quality of an image by extracting individual elements, such as boundaries and property lines. You can also use these filters for object extraction or object recognition by higher-level algorithms.

**EISA** Extended Industry Standard Architecture
**embed** To store a raster image in a drawing, rather than as a file external to the drawing. Embedded images can be viewed in an AutoCAD-based application only if the application is installed with AutoCAD Raster Design or the Object Enabler for AutoCAD Raster Design.

**Enable Mask** A Raster Design option on the Image Mask Properties tab that enables an existing mask for display. Enabling allows you to view the image clip as defined by the image mask.

**encoding** Compression method that is applied to an image when the image is saved. An encoding method can compress the image file to save disk space.

**enhanced bitonal region object** A type of raster entity manipulation (REM) object that includes several lines, arcs, or circles within a bitonal raster image. For illustrated definitions of the types of enhanced bitonal region objects, see “connected” and “smart” in this Glossary.

**equalization** A function that brings out details in an image. Equalization changes the darkest pixels in an image to black and the lightest pixels to white, then reassigns the remaining pixels to use all of the colors in between. Also called non-linear contrast stretch.

**erase** To remove an image insertion from a drawing. This operation removes the image and frame from the drawing, removes the insertion object and its color map from the toolspace, but leaves an unreferenced data definition in the image data view. The color map is not erased from the image data view if it is used by other insertions. To reverse an erase operation, do a new insertion from the data definition object. Whether an erased image is also detached depends on how the Image Detach Options are set on the User Preferences tab of the Raster Design Options dialog box. See also detach.

**ESRI Grid** An image format used in ESRI GIS products. This format is available in ASCII and binary versions.

**Export** A Raster Design command for saving an image to another file format and writing out correlation for the image. The correlation stores insertion point, scale, rotation, and density information for the image. When you export an image, you can choose what type of correlation to create. You can save the correlation data to a resource file, a world file, or to the image file. The type of correlation you can create depends on the type of image being exported.

**fillet** A rounded corner where two lines meet. Raster Design can apply fillets of specified radius to line intersections in bitonal images.

**filter** An editing tool that can be used to adjust the appearance of an image. Example: The Invert filter reverses light and dark areas on an image. Also called editing filter.
FLIC  Acronym for the image format Animator FLIC.

follower  A vectorization tool that traces raster lines in a bitonal image and creates vectors that AutoCAD recognizes as individual objects.

foreground color  The color of the raster objects in a bitonal image. The other color in the image is the background color.

frame  A rectangular vector object that encloses an image. You can select the image frame by clicking it, or by using any AutoCAD selection method. The image frame is an AutoCAD object that you can assign to a layer, reposition, or scale, using standard AutoCAD methods. A frame can become an irregular shape if the image is cropped or clipped. See also image frame.

color frequency  In a histogram image, the frequency value of a color or shade of gray: the number of pixels that use the indicated tone.

Gap Width  A setting that defines the maximum gap (from 0 to 10 pixels) that Raster Design can ignore as it follows a raster line, polyline, or contour. Raster Design ignores any gap that is equal to or smaller than the Gap Width. This setting is useful for scanned images that have many disconnected raster lines or in which pixels are missing as a result of imperfect scans.

geo-referenced image  An image that references real-world coordinates in its correlation source. Example: Geo-referenced images include GeoSPOT, GeoTIFF, and images that use world files as their correlation source.

GeoSPOT  An image format from SPOT Image Corporation that supports georeferencing information.

GeoTIFF  A type of tagged image file format (TIFF) that supports geo-referencing information.

GIF  Graphics Interchange Format. A raster image format created by Compuserve.

GIS (Geographic Information Systems)  Computerized decision support systems that integrate spatially referenced data. These systems capture, store, retrieve, analyze, and display such data.

global coordinate system  A method for defining points on the earth in a Cartesian coordinate system, taking into account the curvature of the earth's surface.

gradient directional edge enhancement filters  Filters that improve the quality of the line where an object begins or ends by extracting individual elements. These filters use the vector sum of the three coordinate variables X, Y, and Z, taking into account their direction in space. You can use the gradient
directional edge enhancements filters in any one of the eight compass directions. Use of these filters results in a black background with white outlines of the objects in the image.

**grayscale image** An image usually created by a scanner in which continuous tones are represented as uniform shades of gray. Each pixel uses eight bits of information, producing 256 shades of gray.

**grip(s)** Small boxes displayed at various points on a selected object that can be used to edit the object. Select a grip and then specify a grip editing function.

**hide** To remove an image from the display while retaining it in active memory. The image frame remains visible. To reverse a hide operation, select the image frame or the toolspace object, then right-click and select Show. See also detach.

**high pass filters** A means for enhancing the edges of images. Images that do not appear clear may also be sharpened by high pass filtering.

**histogram** A bar graph that shows the number of pixels for each color in the selected image or images. An aid for image editing operations.

**hybrid** A type of drawing that includes both raster and vector data.

**IG4** Acronym for the image format Group 4 data with IST headers.

**IGS** Acronym for the image format Image Systems Gray Scale.

**image** A graphic that is composed of raster data. See also drawing image.

**image format** The method in which an image was created and saved, such as bitmap, CALS, RLC, or GIF. Some image formats, such as PICT, are read-only.

**image frame** A frame that encloses each image you insert (also called a boundary). If you select an image frame, grips appear and hatch marks are drawn over the image to indicate that you have selected it. See also frame.

**Image Properties** The properties of color, layer, and frame linetype settings of each image.

**image selection** A collection of data treated by Raster Design as a unit. Example: When you select an image by clicking its frame, the image moves to the top of the display order, obscuring any vectors that intersect with it.

**image unit** The unit at which an image was scanned or created. Example: If you scan an image at 300 dots per inch, the image unit is inches.

**Index Color (8-bit)** An image type that contains up to 256 colors.

**index value** The numeric identifier (0 to 255) of a color or shade of gray. These values are used in the Histogram and the Palette Manager.
invert A filter used to reverse position, order, or relationship. Example: You can invert the image to create a positive image. Use the Invert filter to reverse the dark and light areas of an image.

JFIF - JPEG Acronyms for image formats created by Joint Photographics Expert Group. JFIF is JPEG File Interchange Format. It uses a compression scheme that gives preference to compression rather than data preservation. Best suited for 24 bit images.

JPG2000 An advanced raster image format from Joint Photographics Expert Group, featuring options for lossless compression, wavelet compression, incremental decompression, and support for up to 48-bit color.

Lanczos A pixel resampling method that computes the value for a new pixel by interpolating the value of a 6x6 block of surrounding pixels.

Landsat FAST L7A A multispectral image format used by Landsat 7 satellite, which was launched in 1999.

layout Management of images, to determine how they are displayed and in what order they are listed in the Image Management dialog box.

linetype The display style of a line, such as continuous or dashed.

low pass filter A means of extracting individual elements in areas where pixel intensities change rapidly, thereby reducing high-frequency detail. The effect is a slightly blurred image.

LZW A file compression algorithm, commonly used with TIFF and GIF files.

Maintain Drawing Link A Raster Design export option that, if selected, overrides the image you selected to export.

mask An object used to display and plot a subset of the images in your drawing. A mask clips the images inside the mask boundary and hides or unloads the images completely outside the mask boundary. The mask boundary is an AutoCAD object that you can move, stretch, scale, and erase, like any other AutoCAD object.

median filter A convolving filter that removes random visual speckles from an image by changing each pixel value to match the average value of the neighboring pixels.

merge commands Raster Design commands used to merge images, merge vectors into raster images, and select raster pen widths.

merge images To group two or more images into a single image file.
mirror  To create a new version of an existing object by reflecting it in relation to a line or plane. Example: Scanning software might mirror a drawing, or you might scan the back of a drawing by mistake. You can correct these problems by mirroring the image.

Mitchell  A pixel resampling method that uses a cubic spline technique. It is widely considered to provide a good compromise between ringing and blurring artifacts on most images. See also blurring artifacts, ringing artifacts.

monolithic  Encoding method for TIFF files. Saves image data in one piece, and may result in slower processing time. See also data organization.

multispectral image data  Data recorded in the form of multiple bands. Each band records the values in a specific range of the spectrum, such as infrared, visible, or ultraviolet. Data gathered by satellites is typically provided in multispectral format. A band assignment color map is used to create false color images from these bands. The color map can be configured to highlight surface features, such as vegetation and water.

native capture  Copies a REM object using the image data directly from the image file, ignoring display scale and rotation of objects. Used only for the REM Copy To Clipboard command.

nearest neighbor  A pixel resampling method that assigns to a new pixel the value of the closest pixel in the original image. This is the fastest resampling method, but it produces the crudest results.

Never Detach  An option in the Raster Design Options dialog box that does not detach an image even if all image frames that reference the image are erased from the drawing.

NITF  National Imaging Transmission Format. This multiframe image format is commonly used by US federal agencies and NATO.

node  In Raster Design, a link end point that can be represented as a block or point object. Example: You can force the line follower to ignore the intermediate nodes and draw a single straight line between the start and end points of a line.

noise  Random pixels that can result from poorly scanned images.

non-georeferenced image  An image that does not include real-world coordinate information.

non-linear contrast stretch  See equalization.

non-orthogonal image  A graphic representation that intersects or lies at angles other than right angles. Also called non-ortho image.
**ortho-corrected image** An image that is corrected so all pixels represent their true locations on the face of the earth, making directions and distances accurate. Errors resulting from parallax, lens distortion, and other causes are corrected.

**orthogonal** Intersecting or lying at right angles (0, 90, 180, or 270 degrees).

**palette** The range of up to 256 colors used in an 8-bit image.

**parallax** The apparent displacement of position of an object, caused by a shift in the point of observation.

**PCX** A simple run-length encoded image format.

**Pick** < A Raster Design device for selecting points on the screen.

**PICT** An image format created by Apple Computer.

**pixel** A single dot on the screen. Pixels are the building blocks of raster images, and are individually assigned different colors or shades of gray. Image pixel size varies depending on the resolution of the image. A 2x2 pixel in a 400 dpi image is one quarter the area of a 2x2 pixel in a 200 dpi image.

**pixel size** Image density expressed as the area of a pixel, typically used with aerial photography and satellite imagery.

**PNG** Portable Network Graphics. A raster image format.

**positive image** An image in which the light and shade areas correspond to the original image.

**PPI** Pixels per inch. Also called dpi, or dots per inch. See also DPI.

**projection** Data devised by cartographers and mathematicians to depict three-dimensional shapes (like the earth) on two-dimensional surfaces with known distortion.

**quad sheet** A device for reducing image file size. Many maps are broken up into quadrants, which are square and are called quad sheets. When a group of quad sheets is inserted into a drawing, the drawing is considered to be tiled.

**QuickBird TIFF** A multispectral image format produced by DigitalGlobe from its QuickBird satellite.

**raster data** A series of dots, or pixels that form an image. This type of data is produced when you scan a paper drawing, a blueprint, or a photograph. A raster image is composed of pixels.

**raster entity** A series of contiguous pixels that form a single entity such as a line, rectangle, or circle. Raster Design can recognize such entities and create
vector entities or regions that can be more easily edited than the raster originals.

**raster entity manipulation (REM)** An object-oriented method of editing raster entities in bitonal, color, and grayscale images. REM handles raster entities much like vector objects. There are three types of REM objects: region objects, enhanced bitonal region objects, and primitive objects.

**raster impact point** The point where a vector polyline intersects a raster entity.

**raster object** A distinct line, circle, or arc in a bitonal raster image. Raster objects can be vectorized or edited using raster entity manipulation.

**raster pen** A Raster Design tool that allows thickening of vector objects when you merge them into the image. Thicknesses are assigned according to the specified entity color.

**raster snap** A setting that automatically places the cursor at the end, center, corner, intersection, or edge points on a bitonal raster entity. If you choose more than one snap mode, then the crosshairs snap to the closest of the possible snap points.

**resolution** The number of dots per unit at which an image is scanned or created. Example: An image scanned at 600 dots/inch (dpi) has a higher resolution than one scanned at 300 dpi.

**resource file** A file used by Raster Design to store image correlation data such as insertion point location, scale, and rotation. Resource files have a .res extension. They can be created by the Export command and can be read only by Raster Design. See also world file.

**RFT** Revisable form text.

**RGB** Red-green-blue color channels.

**ringing artifacts** A loss of image detail that can occur with image compression and resampling techniques. The symptoms include ripples or similar interference along edges where two dissimilar colors meet. The sharpness of the edges is degraded.

**RLC** Run-Length Coding raster image format. Raster Design can read RLC1 and RLC2. RLC 1 is a plain RLC with no header. RLC2 is an RLC1 with IST headers. See also run-length coding.

**RLC2** Run-Length Coding raster image format with IST headers. See also run-length coding.
**rotation angle** The angle at which an image is being revolved about its axis.

**RTF** Rich text format

**rub** To remove a line or area from an image with a Raster Design Rub command (e.g., irubline, irubarc). A rub changes the pixels in a selected area to the transparent color. When background transparency is turned on for the image, the rubbed area becomes transparent. Rub permanently alters your image.

**rubbersheet** To match points in an image to known reference points in a coordinate system by warping the image using a triangular or polynomial transformation.

**run-length coding** A data compression method that replaces a run or sequence of identical data units (such as pixels) with a single unit and the length of the run.

**saved path** The image file name saved in the drawing. It can be a simple file name, a local path, a network path, or an Internet address.

**scale** The defined dimensional relationship between units of linear measurement on the earth's surface and those on a map or aerial photo.

**scaling** A method of proportionally changing the size of a raster image in reference to existing raster or vector entities without rotating it.

**shading** The use of marking made within outlines to suggest three-dimensionality, shadow, or degrees of light and dark in a picture or drawing. Example: You can use the sharpening filters on grayscale images to make differences in shading more distinct. It may be necessary to use sharpening filters to extract the highest amount of useful data from a low-resolution scan.

**sharpening filters** A device for enhancing details in images. Sharpening filters, with the exception of the matched filters, use spatial filtering with a 3x3-pixel kernel.

**Show Image Frame(s)** An option on the Image Mask tab of the Raster Design Options dialog box. Shows the frames of the images that are hidden or unloaded.

**SID (MrSID)** Multiresolution Seamless Image Database. A highly-compressed image format from LizardTech, Inc.

**Single Image Optimization** A Raster Design feature that automatically selects your image when you run a Raster Design command that requires an image to be selected. You are prompted to select an image only if you are working with multiple images.
**smart crossing polygon** A selection method for enhanced bitonal region objects. This method selects all raster entities that lie within or cross into the polygon you draw. If any part of the entity crosses the polygon boundary, the entire entity is selected. In the following example, note that the horizontal lines and the circle are selected because they cross the polygon boundary.

![Smart crossing polygon](image1)

**smart crossing window** A selection method for enhanced bitonal region objects. This method selects all raster entities that lie within or cross into the rectangular window that you draw. If any part of the entity crosses the window boundary, the entire entity is selected. In the following example, note that two horizontal lines that cross the window boundary are selected.

![Smart crossing window](image2)

**smart fence** A selection method for enhanced bitonal region objects. This method selects all raster entities that touch a selection polyline (fence) that you draw. Entities enclosed by the fence but not touching it are not selected. In the following example, the text 8.94 is not selected because it does not touch the fence.

![Smart fence](image3)
smart window A selection method for enhanced bitonal region objects. This method selects only the raster entities that lie entirely within the rectangular selection window. In the following example, the arrow and number within the window are selected, but the horizontal lines that cross the window boundary are not selected.

smart window polygon A selection method for enhanced bitonal region objects. This method selects only the raster entities that lie entirely within a polygon that you draw. In the following example, the circle and horizontal lines that cross the polygon boundary are not selected.

smoothing filters A device for removing details or unwanted speckles in images. Smoothing filters use spatial filtering with a 3x3-pixel kernel.
**snap window** The square region, centered on the cursor crosshairs, where entity selection can occur when raster snap mode is active; also known as the aperture.

Snap window

You can also specify minimum and maximum pixel widths to snap to. The snap window snaps only to the bitonal objects that are between the minimum and maximum pixel widths.

**source point** The location from which you move an image. To move an image, you must select a source point and a destination point.

**spatial resolution** Image density expressed in pixels per unit, typically used with scanned images.

**speckle** An unwanted random spot in an image. Speckles or stray pixels can often appear in an image when you scan drawings or blueprints that are dirty or wrinkled. You can remove speckles from your bitonal images by using the Despeckle filter.

**stripped** Encoding method for TIFF files. Breaks up image data into strips for quicker processing. *See also* data organization.

**supported image types** Raster Design supports bitonal, grayscale, and up to 24-bit color images, along with digital elevation models (DEM), multispectral imagery, and generic integer data in 16- and 32-bit format.

**TARGA** A raster image format created by Truevision Inc. Usually 16-bit or 24-bit true color. Can be 8-bit grayscale or simple run-length coded.

**Threshold** A Raster Design operation for converting color or grayscale images to bitonal format. Within the range of grayscale values in an image, the threshold marks the upper limit of black pixel values and the lower limit of white pixel values. Raster Design can set the threshold value automatically, but you can manually adjust it before conversion, using the Threshold tab of the Histogram dialog box.
thumbnail A miniature representation or preview of an image. Thumbnails are used in the Raster Design Insert Image dialog box, the Histogram dialog box, and the AutoCAD Image Adjust dialog box.

TIFF Acronym for the tagged image file format.

tiled Encoding method for TIFF files. Breaks the image data into rectangular, tiled regions for quicker processing. See also data organization, quad sheet.

toggle To switch between two options of an electronic device, usually by pressing a single button. Example: The Raster Design Toggle command changes the visibility of the image frame.

transparent color A selected color that is transparent in a grayscale or color image. If background transparency is turned on for the image, all pixels of the transparent color become transparent. Any time you use a Rub command, the color of the rubbed area is changed to the transparent color.

true color (24-bit) image An image that can contain up to 16.7 million colors. This image type is composed from three 8-bit data bands: red, green, and blue.

unembed To remove an embedded image from a drawing. The unembedded image must be saved as an independent file. See also embed.

unload To remove image data from the display and the working memory of a drawing. The image frame remains visible, and the image object remains in the Image Manager Toolspace tree. To reverse an unload operation, do a reload. See also detach.

vector A mathematical object with precise direction and length, but without specific location. Vector data is stored as XYZ coordinates that form points, lines, areas, and volumes.

vectorize Converting a bitonal raster image to vector data. You can use the Raster Design vectorization tools to vectorize a raster image. See also follower, VTools.

VTools Raster Design vectorization tools used to manually convert bitonal raster arcs, circles, lines, or rectangles to equivalent vector objects.

VTools Removal A setting on the VTools General tab of the Raster Design Options dialog box that controls what happens to the underlying raster entity when vectorization tools are used to vectorize the raster entity. Depending on the Removal Method setting you choose, the raster entity can be rubbed or REM deleted.

wavelet Multiple resolution image files compressed to a small fraction of their original size.
**world file** A file that stores correlation information for an image, consisting of scale, rotation, and insertion point. World files can be created by the Export command to correlate an image in another graphics application. The world file is in ASCII format that you can view using Notepad. World files are saved in the folder where the image is located. Their extensions vary, depending on file type, but always end in w. Examples:

- BMP - bpw
- GIF - gfw
- IG4 - i4w
- TIFF - tfw

**X Y and Z coordinates** Any of a set of numbers used to specify the location of a point on a line, on a surface, or in space.
## Index

3D Polyline Follower, vectorization tool 76

### A

active image 21  
AutoCAD coordinate system, correlating images within 31  
editing commands 23  
imaging commands 22, 24  
text or Mtext, converting raster text to 47  
AutoRub 56

### B

binary images. See bitonal images 6  
bitonal images 6  
making transparent 39  
snapping to 42  
vectorizing with VTools 44  
boundary. See frame 7  
brightness and contrast 22, 72

### C

clean image 53  
color  
changing color depth 40  
displaying in Palette Manager 42  
rub and crop 56  
transparency 39  
color images  
adjusting appearance with histogram 72  
making a color transparent 39  
color map 10  
assigning 29  
DEM 62  
editing 62  
  multispectral 63  
commands  
AutoCAD imaging commands 22, 24  
command line 20, 83  
Image menu 16  
Raster Design commands 83  
Raster Design toolbar 19  
configuration of Raster Design 14  
Contour Follower, vectorization tool 76  
contrast in images 22–23, 72  
converting  
  color and grayscale to binary 72  
  color to grayscale 72  
  image format 34  
  image to a different format 35  
  raster text to AutoCAD text or Mtext 47  
  raster to vector 44  
convolving filters 40  
coordinate system transformation 34  
correlating images 31, 35  
Correlation Wizard 28  
creating correlation files 35  
rubbersheeting 32  
using Quick Insert 28  
using the Correlation dialog box 28  
correlation files 23, 31  
cropping 56

### D

DEM color map 62  
DEM display 62  
deskew 40  
despeckle image 53  
despeckling images 40  
digital elevation model (DEM) display 62  
disk space requirements 13  
DVIEW command 24
Dynamic Input vectorization
prompts 44

E
editing images
  AutoCAD commands 23
  band assignment color map 63
  color depth 40
  filters 40, 72
  histogram 72
  histogram editing filters 72
  image editing commands 40
  indexed 68
  palette color map 62
  REM 60
  rubbing and cropping 56
  embed image 34
  enhanced bitonal region object, REM 49
  fence selection 50
  window selection 50
  enhancing images 40
  exporting images 35

F
  files, correlation 31, 35
  filters for image editing 40, 72
  follower tools. See VTools
  frame
    assigning color and layer 7
    selecting 32

G
  grayscale images 6
  adjusting appearance with histogram 72
  making a color transparent 39

H
  hardware requirements 13
  Help 2

I
  IMAGE command, AutoCAD 23
  Image Manager dialog 20
  Image menu commands 16, 83
  image types supported 80
  images
    attaching 23
    brightness and contrast 72
    changing properties 37
    converting 34–35, 72
    correlating 28, 31, 35
      See also correlating images
    creating new 36
    despeckling 53
    display order 21
    displaying data about 21
    editing. See editing images
    embedding 34
    enhancing 40, 72
    exporting 35
    inserting. See inserting images
    managing 21, 23–24
      See also managing images
    masking 39
    moving 31
    removing raster areas 56
    rubbersheeting 32
    saving 14, 34
    selecting 32
    selecting active image 21
    supported formats 79
    tonal adjustments 22–23
    vectorizing with VTools 44
      See also VTools
    zooming to 21
  imaging commands, AutoCAD 22
  indexed images, editing 68
  InfoCenter 3
  inserting images 23, 27
      Correlation dialog box 29
      correlation files 23
Correlation Wizard 28
from Internet 28
Quick Insert 28
Internet, inserting images from 28
inverting images 40

L
Line Follower Extension (LFX) tools 45, 76, 78

M
maintaining link to image 36
managing images 23
Image Manage dialog box 21
using AutoCAD commands 24
managing images. See images 21
mask, creating 39
matching images 31
menus, accessing commands 16
merging vector data 70
mirroring images 40
moving images 31
multiline text (Mtext), converting raster
text to 47
multispectral data display 63

O
Object Snaps 25
online Help. See Help
Optical Character Recognition (OCR)
See also text recognition
option settings in Raster Design 14

P
Palette Manager 41, 68
pixels 6
changing values 72
making transparent 39
removing 56
platform requirements 12
Polyline Follower, vectorization tool 76, 78
Polynomial method, rubbersheeting 33
preferences, Raster Design 14

Q
quantile distribution 63
Quick Insert, automatic correlation
with 28

R
raster
editing 56, 72
pens 70
raster data definition 6
snapping to 42
text. See text recognition
Raster Design
accessing menu commands 16
Image menu commands 83
news group 6
option settings 14
system requirements 11
toolbar commands 19
using command line 20
Web home page 6
raster entity manipulation. See REM objects
raster images
editing with REM objects 51
merging vectors into 70
raster pens 70
raster snap modes 42
raster text, converting. See text recognition
read-only formats 34
Recognize Text command 47
See also text recognition
REGEN 24
region objects, REM 48–49
REM objects 47
editing raster images 51, 60
enhanced bitonal region 49
primitive 48
region 48–49
resource files, Raster Design 31, 35

Index | 115
rotating images 31
rubbersheeting 31–32
rubbing 56

S
saving images 34
scaling images 31
selecting images 32
separating vectors 46
Shift + Left-click Image Select 32
snap modes
  object 25
  raster 42
snap window 43
software requirements 12
standard deviation distribution 63
system requirements, Raster Design 11

T
tables, converting text to AutoCAD
text 47
technical support 6
text recognition 47
tonal adjustment 22–23
  brightness and contrast 23
  histogram editing filters 72
toolbars, Raster Design 19
training programs 5
transform coordinate system 34
transforming images, rubbersheeting 32
transparency color 38–39
Triangular method, rubbersheeting 33

U
UCS, rotating 24
UNDO command 24

V
vector data 7
vectorization 8, 44
vectorization with Dynamic Input
  prompts 44
vectors
  merging 70
  using raster pen widths 70
VTools 8, 44
  configuring settings 16
  follower tools 45, 76, 78
    3D Polyline Follower 76
    Contour Follower 76
    Polyline Follower 76, 78
  vector separation 46
  vectorizing raster entities 44

W
Web home page, Raster Design 6
world files 35